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Trademarks

AJA®, KONA®,  Ki Pro®,  KUMO®,   and XENA® and are registered trademarks of AJA Video, Inc, 
Io Express™, Io HD™,  Io™, and Because It Matters™ are trademarks of AJA Video, Inc. Apple, 
the Apple logo, AppleShare, AppleTalk, FireWire and Macintosh are registered trademarks of 
Apple Computer, Inc. Final Cut Pro, QuickTime and the QuickTime Logo are trademarks of 
Apple Computer, Inc. TASCAM is a registered trademark of TEAC Corporation. 

All other trademarks are the property of their respective holders.

Notice

Copyright © 2011 AJA Video, Inc. All rights reserved. All information in this manual is subject 
to change without notice. No part of the document may be reproduced or transmitted in 
any form, or by any means, electronic or mechanical, including photocopying or recording, 
without the express written permission of AJA Inc.

FCC Emission Information

This equipment has been tested and found to comply with the limits for a Class A digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference when the equipment is operated in a 
commercial environment. This equipment generates, uses and can radiate radio frequency 
energy and, if not installed and used in accordance with the instruction manual, may cause 
harmful interference to radio communications. Operation of this equipment in a residential 
area is likely to cause harmful interference in which case the user will be required to correct 
the interference at his own expense. Changes or modifications not expressly approved by 
AJA Video can effect emission compliance and could void the user’s authority to operate 
this equipment.

Contacting Support

To contact AJA Video for sales or support, use any of the following methods:

180 Litton Drive, Grass Valley, CA. 95945 USA

Telephone: 800.251.4224 or 530.271.3190
Fax: 530.274.9442

Web: http://www.aja.com
Support Email: support@aja.com 
Sales Email: sales@aja.com

When calling for support, first read the Chapter on Troubleshooting at the back of this 
manual. You can often save time and effort by looking there first for simple remedies and 
information on how to get support from AJA.
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Limited Warranty

AJA Video warrants that this product will be free from defects in materials and 
workmanship for a period of three years from the date of purchase. If a product proves 
to be defective during this warranty period, AJA Video, at its option, will either repair 
the defective product without charge for parts and labor, or will provide a replacement 
in exchange for the defective product.

In order to obtain service under this warranty, you the Customer, must notify AJA Video 
of the defect before the expiration of the warranty period and make suitable 
arrangements for the performance of service. The Customer shall be responsible for 
packaging and shipping the defective product to a designated service center 
nominated by AJA Video, with shipping charges prepaid. AJA Video shall pay for the 
return of the product to the Customer if the shipment is to a location within the 
country in which the AJA Video service center is located. Customer shall be responsible 
for paying all shipping charges, insurance, duties, taxes, and any other charges for 
products returned to any other locations.

This warranty shall not apply to any defect, failure or damage caused by improper use 
or improper or inadequate maintenance and care. AJA Video shall not be obligated to 
furnish service under this warranty a) to repair damage resulting from attempts by 
personnel other than AJA Video representatives to install, repair or service the product, 
b) to repair damage resulting from improper use or connection to incompatible 
equipment, c) to repair any damage or malfunction caused by the use of non-AJA Video 
parts or supplies, or d) to service a product that has been modified or integrated with 
other products when the effect of such a modification or integration increases the time 
or difficulty of servicing the product. 

THIS WARRANTY IS GIVEN BY AJA VIDEO IN LIEU OF ANY OTHER WARRANTIES, EXPRESS 
OR IMPLIED. AJA VIDEO AND ITS VENDORS DISCLAIM ANY IMPLIED WARRANTIES OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. AJA VIDEO’S 
RESPONSIBILITY TO REPAIR OR REPLACE DEFECTIVE PRODUCTS IS THE WHOLE AND 
EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR ANY INDIRECT, SPECIAL, 
INCIDENTAL OR CONSEQUENTIAL DAMAGES IRRESPECTIVE OF WHETHER AJA VIDEO OR 
THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES.
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Chapter 1: Introduction

1

Edge Shot Photo Here

Overview 

The AJA KONA series brings the highest quality 3G, 2K, HD, and SD video and audio to a 
Windows workstation. This manual discusses the KONA for PC software plug-ins that provide 
powerful features to Windows video applications. Although this manual is written for the 
Windows plug-ins, it also applies to AJA Mac Plug-ins for Adobe which run under OSX Snow 
Leopard and Lion (the screens and functions are mostly identical).

Applications 
Supported

With KONA Software version 5.5.2 for PC’s professional features, you can run these Windows 
platform applications (application software not included). 

• Adobe Premiere Pro CS5.5

• Adobe After Effects CS5.5

• Adobe Photoshop CS5.5

• Eyeon Fusion 6.x (64-bit only)

KONA for PC software also offers AJA’s own Machina software for incredible standalone file 
capture, preview and playout with full machine control. Third-party native support for KONA 
cards is also available in applications such as Avid Liquid Chrome, Sony Vegas, and Sonic 
CineVision (see “Native Support for KONA for PC Products ” on page 89).

Note:  AJA KONA and Io Express users can receive a free copy of Drastic Software's MediaNXS 
LE(TM) control software for Windows. The MediaNXS LE software provides you with a 
wide range of advanced functionality including: batch capture, EDL export and advanced 
image monitoring tools. Click on the link below to go to the Drastic website and 
download the software or find out more.

http://www.medianxs.com/

KONA version 5.5.2 software and plugins are also compatible with the Bootcamp Windows 
environment on Macintosh machines running OSX Snow Leopard or better.
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Currently offered KONA card models require a PCIe bus. KONA cards offer high-quality 
digital and analog interfaces for use in broadcast, editing and graphics/animation work. The 
KONA 3G card can capture SDI, HD-SDI, Dual Link 4:4:4 HD-SDI, and HSDL. The 3G card also 
provides an HDMI 1.4a output. KONA LHi captures analog and digital HD/SD data and also 
supports HDMI in and out. KONA LHe Plus provides flexible standard definition and high 
definition capture and playback, a hardware downconverter for working in mixed SD/HD 
environments—and it supports both analog and digital audio/video I/O.

Capture Formats When capturing, you can record data in the following file formats:

• DPX

• Cineon

• TGA

• TIFF

• BMP

• YUV

• AVI 

• QuickTime

• MXF MPEG (Sony Vegas only)

DVCProHD Support KONA cards also include a DVCProHD Library that enables users to capture, edit, and play 
back DVCProHD compressed QuickTime files in KONA for PC supported applications.

For more information on using DVCProHD for:

• Compressed Online Editing,

• Compressed Offline Editing,

• Import, Editing, and Playing Multiple Media Types,

• Cross-Platform Workflow with KONA and DVCProHD

Please see the whitepaper DVCProHD Editing with KONA at:

http://www.aja.com/pdf/AJA_whitepaper_DVCProHD_editing.pdf

KONA Models 
Covered in this 
Manual

Note:  This manual covers the installation and operation of KONA LHe Plus, KONA LHi, and  
KONA 3G models and discusses using them with supported applications. The current 
version KONA 3G is documented here. For information about the earlier KONA 3/3X, 
you may find the user manual online at:

http://www.aja.com/pdf/KONA_PC_Manual_5.0pdf

Instructions for installing the optional breakout boxes are shipped with the option. 
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KONA 3G Features 

 KONA 3G features 10-bit uncompressed video 3G/HD/SD SDI I/O, new HDMI 1.4a output 
for stereoscopic monitoring to consumer 3D displays, 8-channel AES digital audio I/O (16-
channel AES with optional K3G-Box) and 16-channel SDI embedded audio I/O, real-time 
hardware-based up/down/cross conversion to support a range of SD and HD, dual-link 
HD, even 2K formats, a hardware-based downstream keyer and more. 

It captures uncompressed 10-bit and 8-bit digital video and 24-bit 48 kHz digital audio in 
Standard definition (SMPTE 259M), High definition (SMPTE 292M), Dual Link High 
Definition (SMPTE 372M), and 3G-SDI (SMPTE 424M).

KONA 3G features include:

• SDI, HD-SDI, Dual Link SD and HD-SDI, HSDL, and 3G-SDI

• HDMI 4.1a output supporting stereoscopic 3D.

• KONA software plugins and support for third-party applications

• AJA’s standalone Machina capture/playback software

• Native support for uncompressed DPX, Cineon, TGA, TIFF, BMP, YUV, and AVI and 
QuickTime files

• Support for 2K frame formats

• Look Up Table support (LUT)

• 4-lane PCI-express bus interface (KONA 3G)

• Broadcast-quality hardware 10-bit up-convert, down-convert and cross-convert.

• 12-bit HD component and SD component/composite analog output

• 16-channel SDI embedded audio and 8-channel 48 kHz AES audio

• RS-422 machine control

• Cables standard, K3G-Box breakout optional

Dual Link KONA 3G supports Dual Link 4:4:4 HD-SDI. KONA 3G Dual Link supports full-bandwidth 
4:4:4 RGB at 10-bits (12-bit capable) for 1080i, 1080p, and 720p formats. KONA 3G can also 
convert between 4:4:4 and 4:2:2 formats for Single Link HD-SDI output.

KONA 3G Workflow The KONA 3G path allows you to go straight from telecine to disk with 2K media 
eliminating the steps of using tape stock and then digitizing those tapes for the nonlinear 
editor. KONA 3G capture from 2K telecine directly creates 2K DPX, QuickTime, Cineon, AVI, 
TGA, TIFF, or BMP files. Material can be played out at 2K via HSDL (High Speed Data Link) 
at 15 fps.

KONA 3G allows 2K files to be viewed on HD 1080 24P-supported video monitors. This 
1080 HD playout can also be down-converted to SD in realtime, giving the 2K DI pipeline 
a solution for multi-format video playout of 2K material.

By generating 2K files directly from a Telecine in a multitude of file formats and bit-
depths, you have files available for use on any system and at any stage in production. A 
colorist, effects artist, and editor can immediately use the files.

KONA 3G supports any popular uncompressed SD or HD format, including Dual Link, 2K, 
and 2.970 Gb/s 3G-SDI. It captures and plays back uncompressed 10-bit and 8-bit digital 
video. KONA 3G also includes a variety of 10-bit broadcast-quality features—hardware-
based up-, down-, and cross-conversion to and from HD.

KONA 3G is a 4-lane PCI-express bus card.
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Broadcast-quality 
Conversion

KONA 3G features full 10-bit, broadcast-quality, SD-to-HD up-conversion, HD- to-SD down-
conversion, SD and HD cross-conversion, and automatic HD/SD 12-bit component analog 
output. The quality is identical to AJA’s stand-alone products and all functionality is 
hardware-based making it available all the time on digitize or playback. KONA 3G offers 
hardware-based 1080-to-720 or 720-to-1080 cross-conversion further streamlining dailies 
and deliverables creation at true broadcast picture quality in realtime. For maximum 
flexibility, hardware-based aspect ratio conversion can be applied to standard definition 
capture and output.

Video + Key SDI 
output 

This feature is available on the output settings in Machina, After Effects, and Premiere Pro. 
To use Video + Key, set the SDI-1 Output to ‘Video + Key (V)’ or ‘Video + Key (K)’. The SDI-2 
then output automatically changes to the complimentary setting. 

Note:  Video + Key is limited to 8-bit RGBA files.

KONA 3G Audio KONA 3G’s extensive audio support makes installation simple, working with 8-channel  
24-bit 48 kHz audio via BNC connections, and 16-channel embedded 24-bit SDI/HD-SDI 
audio (capture and playback).

KONA 3G also features high-quality input sample-rate conversion on AES inputs, which 
eliminates the need for audio source synchronization.

KONA 3G I/O KONA 3G offers two HD/SD SDI inputs and outputs and a component analog output, each 
independently switchable between HD and SD (SD analog can be configured as 
composite). For example, if you are working in HD, you can have simultaneous HD-SDI, SD-
SDI, and HD or SD component analog output. Using KONA 3’s always-available format 
conversion features, monitoring can be as simple as a single composite monitor for both SD 
and HD projects. Dual Link can be monitored via Dual Link HD-SDI outputs, Single Link HD-
SDI, or HD component analog. The KONA 3G also provides an HDMI output.

When you plug in KONA 3G’s breakout cables they automatically configure. For SDI video, 
the card features two HD/SD inputs and two outputs for Single or Dual Link, one connection 
for Genlock input, and three for HD/SD component analog video out. Also included is a 9-
pin D connector for RS-422 machine control. The SDI inputs and outputs use a separate 
cable with special mini-BNC connectors on one end and full-size BNCs on the other for ease 
of connection and superior reliability.

The K3G-Box for KONA 3G simplifies interfacing by offering a 19-inch, 1RU rack-mountable 
breakout box that attaches to the KONA 3G with just two custom cables and a standard 
HDMI mini-to-HDMI cable (included with KONA 3G). This option offers all the same inputs 
and outputs as the standard breakout cable, and can be easily rackmounted or placed on 
top of a broadcast monitor or editing desk. Additional functionality includes BNC AES 
output, 2-channel RCA analog audio monitoring, and looping BNC Genlock reference 
connectors. Proper connections are provided for a Betacam deck, HDCAM, DVCPRO HD, D5, 
D9, or even HDCAM SR.
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KONA LHi Features 

The KONA LHi card provides the Windows workstation with both HD and SD analog and digital 
I/O, and HDMI input and output. The LHi SDI I/O BNCs also support 3G-SDI, consisting of a single 
2.970 Gbit/s serial link, standardized in SMPTE 424M.

KONA LHi Features include:

• 10-bit Uncompressed SD/HD Capture Card

• 12-bit HD Analog Component I/O

• 12-bit SD Analog Component or Composite/YC I/O

• 3G, HD-SDI, or SD-SDI input I/O

• HDMI input and output with v1.3a Deep Color at 30 bits per pixel

• 2-channel balanced XLR AES and 2-channel balanced XLR Analog Audio I/O

• 8-channel SDI Embedded Audio I/O

• Broadcast-quality hardware 10-bit up-convert, down-convert and cross-convert.

• Native support for DPX, Cineon, TGA, TIFF, BMP, YUV, AVI and QuickTime files

• HD/SD Genlock

• RS-422 Machine Control

• Cables standard, KLHi-Box breakout box optional

• AJA KONA software, including application plugins and AJA Machina capture/playout 
software

• PCI-express (PCIe) bus interface

• LTC selectable on reference input

KONA LHi I/O The KONA LHi comes standard with a breakout cable, and also works with the optional KLHi-Box 
for rackmounted I/O convenience. It offers multi-channel audio and 16/24/32-bit AES/EBU 
digital audio at 48 kHz for digital production. By including hardware sample-rate conversion on 
AES inputs, KONA LHi eliminates source synchronizing requirements. 

Supporting Digital SD/HD and Analog SD/HD I/O, KONA LHi fits many diverse workflows 
including analog component connections from HDV cameras providing direct ingest of HDV-
acquired material into uncompressed or any other supported file format. These 12-bit analog 
inputs and outputs, and 10-bit digital I/Os, ensure that KONA LHi can interface to almost any SDI 
or analog device.

KONA LHi is a 4-lane PCI-express bus card that provides HDMI in/out and has 1 SDI/HD input and 
1 SDI/HD output. HDMI input and output, effectively allows use of inexpensive but high-quality 
HD camcorders for input and HDMI monitors for low-cost HD program monitoring. 

HD/SD Conversion KONA LHi also provides 10-bit hardware HD-to-SD up-, down-, or cross-conversion that can be 
applied to any or all inputs or outputs. Digitize HD into space-efficient SD for off-line work. 
Monitor HD files on an SD monitor. Make analog or digital SD tape masters from an HD project.
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KONA LHe Plus Features 

The KONA LHe Plus card offers the best solution for affordable SD/HD capture and playback. It 
offers a cost-effective solution for capture, playback, and printing video for non-linear editing 
and visual effects/motion graphics.

KONA LHe Plus features include:

• 10-bit uncompressed SD/HD QuickTime capture card

• 12-bit HD Analog Component I/O

• 12-bit SD Analog Component/Composite/S-Video I/O

• 10-bit hardware HD-to-SD downconversion

• HDV hardware acceleration

• Dynamic RT Extreme hardware acceleration

• One SDI or HD-SDI Input

• Two independent SDI/HD-SDI outputs

• 2-channel analog balanced XLR audio I/O

• 2-channel AES XLR audio I/O

• 8-channel SDI embedded audio I/O

• HD/SD genlock on analog video inputs

• RS-422 Machine Control

• Final Cut Pro, Motion, After Effects, Combustion, and more

• Cables standard

• Optional KL-box Breakout Box—provides rack mounting and flexible easy I/O (KL-box 
cabling is included with the KL-box). When ordering, specify a KL-box for the KONA LHe 
Plus since it uses a unique cable.

The KONA LHe Plus supports DPX, Cineon, TGA, TIFF, BMP, YUV, AVI and QuickTime files 

KONA LHe Plus I/O
KONA LHe Plus can operate with either the standard breakout cable (included) or optional KL-
Box for rackmounted I/O convenience. KONA LHe Plus provides high quality analog and 
digital 10-bit resolution SMPTE SDI standard and high definition video connections. KONA 
LHe Plus also has great audio I/O support—2-channel balanced XLR analog, 2-channel XLR 
AES, and multi-channel embedded SDI audio. KONA LHe Plus includes hardware sample-rate 
conversion on AES inputs eliminating source synchronizing requirements. 

KONA Software 

KONA software consists of KONA application software (Machina™), KONA driver software, and 
KONA plug-in software for 3rd-party applications. This suite of software allows KONA to work 
in a variety of workflows. The plug-ins provide tightly integrated KONA source selection and 
control within 3rd-party applications. KONA software provides direct support for Adobe 
Creative Suite 5.5 including Premiere Pro, Adobe After Effects, Adobe Photoshop, and also 
Eyeon Fusion 6 (64-bit) (application software not included).

With a Windows workstation, and KONA, you have a high-quality cost-effective system for 
standard definition, high definition, digital and analog video production workflows (features 
vary with each model). Software is supplied on CD and on the web for download of the latest 
software versions, including:

• AJA’s Machina Capture/Playback application

• Drivers for the card itself

• All files necessary for interfacing with third-party software applications
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What’s In The Box? 

When you unpack your AJA KONA LHe Plus, LHi or KONA 3G, you’ll find the following 
components:

• AJA KONA for PC Software and Documentation CD-ROM – this CD contains the software 
installer to place KONA drivers, plugins, and the AJA Machina capture/playback 
application on a Windows workstation. The CD also contains a wide variety of useful 
information. (A separate CD is provided with Mac OSX Installation software for KONA use 
on Macs.)

• The KONA model you ordered

• Cable assembly – the appropriate KONA Standard Breakout cable for your KONA card 
(KONA 3G includes HDMI output cable)

• Read Me First Notice – late-breaking news and/or errata related to KONA and the 
documentation

• Registration Sheet – register your card by mail or online (details provided)

KONA Shipping Box Contents (KONA 3G contents shown)

HDMI to HDMI mini cable
2 meters

Read Me First Notice
and Registration Sheet

Standard Cable Set

Installation Software CD

Installation and Operation Manual
in electronic form on the CD (PDF)

AJA KONA 3G
PCI-Express

Card

SDI cable

SDI Out1/Link A BNC

Reference Input BNC
LTC Output BNC

LTC Input BNC

Audio Input BNCs
Channels 1-8

(2 channels/connector)

Audio Output BNCs
Channels 1-8

(2 channels/connector)

RS422
Machine Control

(9-pin)

3 BNCs (Analog Out Connections):
In SD Can be Configured for

Component,
Composite,

or S-Video
In HD Can Only Be Component

SDI Out2/Link B BNC

SDI In1/Link A BNC

SDI In2/Link B BNC
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Minimum System Requirements 

AJA Video recommends that your system meet minimum hardware and software 
requirements to achieve a satisfactory level of performance when operating it. System 
requirements are subject to change as new versions of operating systems, QuickTime, and 
workstations become available. For the most up-to-date Minimum System Requirements see 
the AJA website at: 

http://www.aja.com/support/kona/kona-system-configuration.php

Understanding Disk 
Storage Methods

To ensure performance and quality, the disk storage system used with the Windows 
workstation must be able to meet the demands of storing realtime uncompressed media. At 
the very minimum, the disk storage system must be able to provide and maintain a consistent 
50 MB/s transfer rate from the workstation to disk (read/write). There are a variety of system 
configurations and peripherals that can provide this level of performance. Refer to “Computer 
Requirements for KONA Cards ” on page 19 for information on testing data rates and storage 
performance.

Cable Connections 

KONA offers unsurpassed cable connectivity for a video/audio capture card. Connections are 
made via the supplied breakout cable and connectors mounted on the KONA Card endplate.

Using the Breakout 
Cable and Card 
Endplate 
Connectors

The breakout cables for the three KONA models are shown on the following page.

KONA LHi and LHe Plus Connectors
The KONA LHi and LHe Plus models use a breakout cable that supports:

• Reference Input (BNC connector)

• Component/Composite/S Video Input (3x BNC)

• Component/Composite/S Video Output (3x BNC)

• AES In (2x XLR)

• AES Out (2x XLR)

• Balanced Audio In (2x XLR)

• Balanced Audio Out (2x XLR)

• RS-422 Machine Control (9 pin D)
 
Connectors on the KONA LHi card endplate additionally provide:

• Standard-definition or High-definition SDI input (1 BNC) and output (1 BNC)

• HDMI input and output (2x HDMI mini-connectors)
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KONA LHe Plus Connectors
KONA LHe Plus uses a breakout cable to provide the same audio/video, RS-422 Machine Control, 
and reference I/O as the LHi model.

The KONA LHe Plus endplate provides one BNC for SDI/SDI HD input and two independent SDI/
SDI HD output BNC’s.

Breakout Cables for LHe Plus and LHi Models
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KONA 3G Connectors
KONA 3G provides complete I/O connectivity choices in two multi-signal breakout cables and 
one HDMI-to-HDMI mini output cable. One multi-signal cable provides AES/EBU digital BNC 
connections and analog video monitoring connections. The other has 4 mini-connectors on 
one end and 4 BNCs on the other providing SDI connections for both Single Link and Dual 
Link SD/HD SDI connections. Cable connections are marked on both the KONA card endplate 
and on the cable connectors for easy identification.

KONA 3G Breakout Cable

4-mini BNCs
to 4 standard

BNCs

Reference Input BNC

HDMI Output (1)

RS422 Machine Control to VTR
(9-pin)

SDI Out1/Link A BNC

SDI Out2/Link B BNC

SDI In1/Link A BNC

SDI In2/Link B BNC

Digital AES
Audio Input BNCs

Channels 1-8

Digital AES
Audio Output BNCs

Channels 1-8

LTC Input BNC

LTC Output BNC

SDI 

KONA 3G 
end-plate

3 BNCs (Analog Connections):
Output SD:

Component, Composite, or S-Video
Output HD: Component or RGB
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Using Breakout 
Boxes

The KONA product line offers two optional 19” 1RU rack-mountable breakout boxes that attach 
to the KONA card via cables that connect to the back of the Box. These cables are supplied with 
the Box. The breakout boxes offer the same inputs and outputs as the standard breakout cables 
and more. Breakout boxes can be easily rackmounted or placed on top of a broadcast monitor 
or editing desk.

KONA KL-Box for LHe Plus
The KONA KL-Box is connected via one 60-pin to 60-pin, and one 3-BNC to 3-BNC cable. When 
you purchase the KL-Box, you get two-channel unbalanced audio output (2 RCA Jacks) not 
available with the standard cable. When ordering a KL-Box, specify the KONA card model you’ll 
be using the KL box with to ensure you get the proper cable set.

KL-Box Model Breakout Box

KONA KLHi-Box for LHi Cards
The KONA KLHi-Box offers the same connections as the KL-Box except a single connector is 
provided for the following: SDI input, SDI output, HDMI v1.3a input, and HDMI v1.3a output. 

Note:  The HDMI connectors on the breakout box are full-size, not mini as on the LHi endplate.

KLHi-Box Model Breakout Box

RS422
Machine
Control

External
Reference
(loop)

Analog Audio
Output

Balanced Audio In
Channels 1 & 2

Balanced Audio Out
Channels 1 & 2

Composite/
Component 

Video In

Composite/
Component 

Video Out

AES/EBU Audio
In and Out

In

Serial
Digital

Out

Serial
Digital

RS422
Machine Control

External
Ref. or LTC

(loop)

Analog
Audio

Output

Balanced Audio In
Channels 1 & 2

Balanced Audio Out
Channels 1 & 2

Composite/Component 
Video In

Composite/
Component 

Video Out

AES/EBU Audio
In and Out SDI

In

SDI
Out

HDMI v1.3a
Out

HDMI v1.3a
In



12

K3G-Box for KONA 3G
The K3G-Box for KONA 3G offers convenient connector access and additional functionality 
including simultaneous BNC AES output, 2-channel RCA analog audio monitoring, and 
looping BNC connection for Genlock reference and LTC timecode. If you’re using a digital 
Betacam deck, HDCAM, DVCPRO HD, D5, D9 or even an HDCAM SR, you’ll have the proper 
connections.

K3G-Box Model Breakout Box (front & rear view)

Connector 
Descriptions— 
LHe Plus/LHi Cables 
and KL-Box

Connectors on the standard cable set are labelled by their function for easy installation and 
maintenance. Connectors on the optional KL-Box are similarly labelled.

SDI Input and Outputs
BNC connectors are provided on the KONA LHe and LHi card endplates for one SD-SDI or HD-
SDI input. The LHe Plus has two, and LHi has one SDI output (format independent of the 
input). The SDI input and outputs support video and embedded 24-bit digital audio. Use SDI 
wherever possible for the best quality 10-bit uncompressed video input, capture and output. 
If peripheral equipment has a variety of inputs/outputs, look to see if it has SDI I/O, and use it 
where possible. Most high-end professional broadcast equipment supports SDI (VTRs, 
cameras, media storage servers, etc.).

HDMI Input and Output
Two HDMI mini-connectors on the LHi endplate (full-size HDMI connectors on the KLHi Box) 
provide for input and output of HDMI compatible video (version 1.1) and multi-channel 
embedded audio (8 channels). HDCP is not supported on either input or output. The LHi’s 
HDMI output does not have HDCP, and input sources having HDCP are not supported. The 
HDMI input is designed to support long cable runs—up to 100 ft. when using 22 or 24AWG 
HDMI cable, or up to 50 ft. using 28 or 30AWG HDMI cable. The HDMI output supports 
standard HDMI cables only.

HDMI Output
from KONA 3G

mini-HDMI connector

KONA 3G
Host

Connector 

SDI Ports 1 through 4
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2-Channel Digital AES/EBU Audio Inputs And Outputs
One female XLR connector is provided for the channel 1 and 2 inputs, while a male XLR 
connector carries channel 1 and 2 outputs. AES/EBU signals are handled internally as 24-bit 
digital.The optional KL-Box also provides XLR audio connections on the front panel.

Note:  AES XLR connections are digital and cannot be used with analog equipment having XLR 
connectors.

Analog 2-Channel Balanced Audio
Two sets of analog XLR connectors, one for each channel, support balanced audio connections. 
Male XLRs are provided for outputs and female XLRs are provided for inputs. Balanced audio 
(differential) connections provide better analog audio quality over longer cable runs. Most 
professional quality VTRs and audio equipment have XLR style connectors for analog audio. 
Analog audio signals are converted internally to 24-bit digital.

Analog 2-Channel Unbalanced Audio (KL-Box only)
On the KL-Box are two analog output connectors, one for each channel. These connectors are 
RCA-style phono jacks.

RS-422 Machine Control 
A female DE-9 connector on the LHi/LHe Plus breakout cable provides connection for VTRs, 
camcorders, disk media servers, and other devices using RS-422 SMPTE (Sony) protocol. This RS-
422 connector is also present on the optional KL-Box (connector pinout is Sony 9-pin protocol). 

Connector 
Descriptions—
KONA 3G Cables 
and K3G-Box

Connectors on the standard cable set are labelled for their function for easy installation and 
maintenance. Connectors on the optional K3G-Box (breakout box) are similarly labelled.

8-Channel Digital AES/EBU Audio Inputs and Outputs
When using the standard cables, BNC connections are provided for AES/EBU audio input/
output. Four BNC connectors are provided for audio input and four for audio output. Each BNC 
carries two channels. The connectors are labeled for input/output and channels.

The optional K3G-Box provides BNC audio connections on the front panel for 16-channels of 
audio input and output.

Analog 2-Channel Unbalanced Audio (breakout box only)
On the breakout box are two analog output connectors, one for each channel. These connectors 
are RCA-style phono jacks.

RS-422 Machine Control
A female DE-9 connector provides connection for VTRs, camcorders, disk media servers, and 
other devices using RS-422 SMPTE (Sony) protocol. This connector is present on both the 
general I/O cables and the optional K3G-Box (connector pinout is Sony 9-pin protocol.)
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SDI Inputs and Outputs
On the KONA 3G card, mini-connectors are provided for two SDI inputs and two SDI outputs 
for Single or Dual Link. A cable with four Mini-connectors on one end and four BNCs on the 
other end is provided for connecting equipment to the SDI inputs and outputs.

KONA 3G has four video outputs altogether: 

• two SDI outputs that are used for both High- and Standard-definition (SD/HD-SDI)

• two monitor outputs (discussed later), one component analog and one HDMI 1.4a. 

Each of the four outputs is independently switchable between HD and SD. For example, if you 
are working in HD, you can have simultaneous HD-SDI, SD-SDI, and HD-component analog 
output.

SDI inputs and outputs support video and 8-channel embedded 24-bit digital audio. Use SDI 
wherever possible for the best quality 10-bit uncompressed video input, capture, and output. 
If peripheral equipment has a variety of inputs/outputs, look to see if it has SDI I/O, and use it 
wherever possible. Most high-end professional broadcast equipment supports SDI (VTRs, 
cameras, media storage servers, etc.).

HDMI Output
An HDMI mini-connector on the KONA 3G endplate (full-size HDMI connectors on the  
K3G-Box) provides output of HDMI compatible video and multi-channel embedded audio (8 
channels). HDCP is not supported on the output. 

Analog Monitor Out (Component/Composite HD/SD)
Both the standard I/O cable and the optional K3G-Box feature two groups of three BNC 
connectors each, for input and output of component, composite and Y/C functions. The 
signals are labelled on both the cable and K3G-Box connectors.

The analog component output can be switched between SD and HD. KONA 3G features 12-bit 
component video output for both HD and SD. SD can be switched to composite and Y/C. (The 
same three BNC connectors share component and Y/C functions.) This allows use of an 
inexpensive analog monitor for both HD and SD work. You can even use a composite video 
monitor. For Dual Link HD-SDI output, HD or SD can be monitored through the component 
output. Dual Link HD can be output as 4:4:4 RGB.

Component video signals are generally higher quality than composite, but not as high-quality 
as serial digital (SDI).

Note:  About RGB: Although RGB is used less in today’s video systems, KONA 3G supports it 
for A/V Monitor output. However, because the KONA 3G (and SMPTE SDI’s) native format 
is YPbPr, AJA recommends using YPbPr when the monitor supports it. The YPbPr format 
provides “headroom” for “superwhite” and superblack”—and these video levels will be 
clipped when transcoding to RGB. Also, the RGB/YPbPr transcoding involves a level 
translation that results in mathematical round-off error. RGB can be configured in the 
Playout setup panel of the specific application you are using with KONA 3G.

Note:  About YPbPr: KONA 3G supports three different types of YPbPr: 

• SMPTE/EBU N10

• Betacam (NTSC)

• Betacam (NTSC-J [Japan]).  

These three formats differ in level only and can be configured in the Playout setup panel of 
the specific application you are using with KONA 3G.
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Reference Video
A single BNC on the standard KONA cable—or two BNC connectors on the K3G-Box (looping)—
allow you to synchronize KONA outputs to your house analog reference video signal (or black 
burst). If you have a sync generator or central piece of video equipment to use for synchronizing 
other video equipment in your studio, connect its analog composite output here. When KONA 
outputs video, it locks to this reference signal. When connecting a reference video source, the 
locking signal should be the same format as the Primary format selected in KONA software. It is 
possible in some circumstances to use an alternate format video signal if the basic frame rate is 
compatible.

In This Manual 

This manual is written for the KONA for PC software. The AJA Windows plug-ins information is 
shown throughout the manual using example Windows 7 screens and discussion. This text also 
applies to AJA Mac Plug-ins for Adobe which run under OSX Snow Leopard and Lion (the 
screens and functions are mostly identical). For both Windows 7 and Snow Leopard or Lion 
platforms, use this manual for understanding AJA’s Plug-ins for Adobe CS5.5.

Chapter 1 is the introduction you’re reading, listing features, box contents, system requirements, 
and connection hardware. 

Chapter 2 provides complete instructions for installing the AJA KONA card. The user is guided 
through unpacking, installing the card into a Windows workstation, installing KONA Software 
From CD, cabling the system and getting it up and running. Important configuration 
information is also provided on video settings and use of genlock/external reference.

Chapter 3 discusses KONA features that are common across all its plug-ins and the KONA 
Machina application. Here you’ll find a basic overview of how KONA operates and is configured, 
from making source and format selections to capturing, previewing, and playing back video and 
audio.

Chapter 4 discusses operational aspects of KONA when used with AJA’s Machina capture/
playback application. 

Chapter 5 discusses operational aspects of KONA when used with Adobe Creative Suite 5.5 
including Premiere Pro CS5.5 editing and motion graphics software, After Effects compositing 
software, and Photoshop CS5.5 photo/graphics editing application.

Chapter 6 discusses operational aspects of KONA when used with Eyeon Fusion v6.0 (64-bit) 
software (PC only).

Chapter 7 discusses other third-party applications that provide native support for KONA cards 
(PC).

Chapter 8 discusses troubleshooting problems with your system and what to do when there’s a 
problem you can’t solve. It also provides a list of Frequently Asked Questions (FAQs).

Appendix A contains the technical specifications for the product.
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Chapter 2: Installation & Hardware Configuration

2

Installation Overview

 

The installation and set up of a KONA with a PC is very simple. All of the steps of installation 
and hardware configuration are described in this chapter and are summarized as follows:

1. Unpack the shipping box
2. If not previously installed on your PC, ensure that your editing or capture/playback 

applications are installed as detailed in their user documentation. These applications 
must be installed and have been run at least once prior to installing AJA KONA 
software to allow proper interface setup.

3. Configure your Workstation as appropriate for your workflow requirements. A URL to 
AJA Support is provided for getting the latest tested and approved KONA and RAID 
storage configurations.

4. Install the latest AJA KONA software on your Workstation.
5. Cable the system audio and video sources, VTR, audio monitor, and video monitor. If 

you purchased the optional KL-Box or K3-Box, install it in an equipment rack or place it 
on a desk and connect its two cables to the KONA card. If you are using the standard 
cable set instead, connect those directly to the equipment.

These steps are explained in greater detail in the following pages.
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Unpacking 

Shipping Box 
Contents

Your KONA card is shipped with a breakout cable and two CDs: one KONA for PC and one 
KONA for Mac. Each CD contains software and an Installation and Operation manual (a 
PDF on the CD) for that platform. If you purchased the optional KL-Box or K3-Box breakout 
box, it ships with its own set of cables and instructions for connection to the KONA card.

Contents, KONA Shipping Box

As you unpack the shipping box(es), carefully examine the contents. Ensure you received 
everything and nothing was damaged in shipment. If you find any damage, immediately 
notify the shipping service and supply them with a complete description of the damage 
then contact your AJA dealer or distributor for details on how to have your KONA repaired 
or replaced. AJA will repair or replace damaged items. 

Save packing materials and the shipping box. If you ever require service or move your 
system—use the packaging materials and box for safe shipment.

s
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Computer Requirements for KONA Cards 

For the most up-to-date computer system requirements for KONA, consult the AJA 
website:

PC:

http://www.aja.com/support/kona-pc/kona-pc-system-configuration.php

MAC:

http://www.aja.com/support/kona/kona-system-configuration.php

AJA Data Rate 
Calculator 
Application for 
Windows 

AJA offers a Data Rate Calculator utility for KONA users as a resource for configuring 
systems and determining storage requirements. This application calculates data rates and 
storage requirements for a given video size, format, and frame rate and is available for 
download at:

PC:

http://www.aja.com/support/kona-pc/kona-pc-3g.php

MAC:

http://www.aja.com/products/software.php

(See Utilities and Optional at the bottom of the webpage.)

Note:  Note: It is the storage vendor’s responsibility to maintain sustained playback. 
Many benchmark utilities show a speed test in an ideal setting but will not sustain 
that data rate for sequential data reads/writes as required in a true video editing 
environment. Use the calculator to determine the data rate required and then 
proceed to the system test described below.

AJA KONA System 
Test

KONA System Test is available on the AJA website at the support pages provided for the 
Data Rate Calculator (“AJA Data Rate Calculator Application for Windows ” on page 19).

(See Utilities and Optional at the bottom of the webpage.) KONA System Test is a 
Windows utility for measuring system performance with AJA KONA Video Capture cards. 
The application includes disk drive speed tests and video data copy (DMA) speeds. The 
disk speed tests differ from standard disk I/O performance applications in that they 
specifically test the system under conditions typically encountered with video capture, 
playback, and editing. 

Note:  Note: Most of the disk performance tests are generic and don’t require an AJA 
KONA Video Capture card. The DMA performance tests do require a KONA card and 
AJA KONA Driver software to operate. 

We suggest the best test is to fill your storage disk to 80% and then test capture at the 
highest data rate you will use. Use Machina Capture Status display to monitor lost frames 
(“Capture Controls” on page 53).

http://www.aja.com/support/kona-pc/kona-pc-3g.php
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Installing the KONA Card 

1. Place the PC in a well-lit convenient area, where you will have easy access to the 
chassis access door. 

2. Touch the outside of the PC to discharge any static electricity in your body. Remove 
the power cable from the back of the PC.

3. Open the PC to gain access to the card slots as described in your Workstation User 
Manual.

4. Remove the KONA card from its protective anti-static bag; place the card on top of 
the bag. 

5. To install the KONA card and RAID controller card (SCSI or Fibre Channel), refer to the 
AJA website for the latest installation updates at the URL provided.

Because of hardware and software changes, AJA engineers are constantly testing and 
grading workstation performance. The AJA website is your best source of up-to-date 
approved workstation configurations.

Note:  Always put the RAID controller and KONA on separate PCI busses. This improves 
performance by reducing bus contention.

 

KONA Card placement in HP Z800 Motherboard

1

2

3

4

5

6

7

KONA 3G, LHi, 
or LHe Plus

At the time of this writing, 
AJA supports the KONA 3G, LHi 
& LHe Plus for 2K / HD / SD editing 
on the HP Z800 Workstation. 

DIMM 6

DIMM 5

DIMM 4

DIMM 3

DIMM 2

DIMM 1

DIMM 6

DIMM 5

DIMM 4

DIMM 3

DIMM 2

DIMM 1

CPU 1 CPU 2 

PCI-e 8x (4x)

PCI-e 8x (4x)

SATA 0 SATA 1 SATA 2 SATA 3

SATA 1 SATA 1

SATA 4 SATA 5

SATA 1 SATA 1 SATA 1 SATA 1 SATA 1 SATA 1PCI-e 8x (4x)

PCI-e 16x 

PCI-e 16x 

PCI 33MHz

PCI-e 16x (8x) 
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6. Open the card retainer bar on the left side of the chassis cardcage. Remove the card edge 
access cover from the desired slot where you will be inserting the KONA card. 

7. Holding the KONA card by the card edge plate and an outside edge, carefully insert the 
KONA card by rocking it slowly into the slot. Ensure the card edge aligns properly with 
the PC’s opening (where the card edge cover was just removed) and that it is fully seated 
in the slot.

8. Secure the card in the slot replacing the card retainer bar.
9. Replace the PC’s panel/door removed in step 3.

Locate the correct PCIe Slot and Insert the KONA Card (typical installation shown)
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Cabling KONA 

Make video and audio input/output connections according to your workflow requirements. 
Each connector is described in detail in Chapter 1. In this section, KONA cable connections are 
shown and described for KONA 3G and LHi/LHe Plus breakout cables.

Using The 3G 
Breakout Cable 

KONA 3G Breakout Cable Package

KONA 3G Card

KONA 3G installs
in PCIe Slot in PC

60-pin Connector 
to KONA 3G

KONA 3G Cable Package

4-mini BNCs
to 4 standard

BNCs

Reference Input BNC

HDMI-to-HDMI mini 
Output Cable 

RS422 Machine Control to VTR
(9-pin)

SDI Out1/Link A BNC

SDI Out2/Link B BNC

SDI In1/Link A BNC

SDI In2/Link B BNC

Digital AES
Audio Input BNCs

Channels 1-8

Digital AES
Audio Output BNCs

Channels 1-8

LTC Input BNC

LTC Output BNC

SDI 

3 BNCs (Analog Connections):
Output SD:

Component, Composite, or S-Video
Output HD: Component or RGB
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Dual-link Connections
Using the KONA 3G card, you can take advantage of the speed and quality of Dual-link SDI I/O. 
When connecting for dual-link, use the normally separate inputs and outputs numbered 1 & 2 as A 
and B components of the dual-link (thus the connectors are labeled 1A/2B). When configuring 
KONA Capture plugins, you will select Dual-link for your SDI input and output modes.

Using The LHe Plus/
LHi Breakout Cable 
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A Typical System The following figure shows a typical system interconnections for a system with digital A/V 
sources using the KL-Box for KONA LHe Plus or LHi cards. Your system may differ depending 
on VTRs, audio monitoring, and video monitoring.

1. If desired, connect your house reference sync to the KONA Ref Loop connector (BNC). 
The second KONA Ref Loop connector on the KL-Box (if used) can be connected to the 
VTR or terminated with a 75-ohm terminator.

2. Connect a Video Monitor to the KONA Component Analog Video Out BNC connectors 
(preferred), or connect to a composite monitor.

3. Connect a 9-pin DE-9 machine control cable between your VTR’s RS422 control port 
and the KONA breakout cable RS-422 machine control connector. 

4. Connect two SDI cables between KONA (BNCs are on the card endplate) and your 
digital VTR (Digital Betacam etc.): one from KONA SDI In to the VTR SDI Out, and one 
from KONA SDI Out to the VTR SDI In.  
The KONA SDI connections have embedded audio so the VTR must be configured 
accordingly.

5. If you have an AES/EBU-ready audio monitoring system, connect the two channels of 
AES/EBU output from KONA’s XLR connectors (channels 1 and 2) to the monitoring 
system AES/EBU inputs. If instead you have an analog audio monitoring system, you 
can use either the XLR balanced audio connectors or the two RCA-style unbalanced 
stereo output jacks on the Optional KL-Box for output.

v

Typical System Connections—Shown with Optional KL-Box
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Genlock and Your System 

For video stability and proper system operation, it’s always best to genlock all equipment to 
house sync. Although genlock is not absolutely required for KONA or your system, you will have 
better quality and repeatable operation using it. Usually, this means using a black burst 
generator output looped through the system. On the KONA cables and optional  
KL-Box, KLHi-Box, and K3G-Box breakout boxes, house sync is connected to “Ref Loop”. 

Note:  If you are using the KONA LHi, be sure to set the Reference/LTC connection to Reference 
in the Machina Control Panel (Windows).

Installing KONA Software   

If your PC has previously had another video capture or multimedia card installed, remove the 
card and uninstall any related software before installing KONA. Also, always uninstall existing 
KONA software before installing a new version. This will prevent hardware/software conflicts. 

Note:  Before proceeding, ensure that your capture, editing, or compositing Application 
Software (Adobe or other) is installed as detailed in its user documentation. These 
applications should be installed and run at least once prior to installing AJA KONA software. 

Download the latest KONA software from the AJA website or, if that is not possible, use the CD-
ROM supplied with the KONA system to install necessary software drivers and AJA’s Machina 
Capture/Playback application (if desired). Software updates occasionally become available to 
AJA KONA owners on our website at:

http://www.aja.com/support/index.php

We recommend checking for both software updates and additional product information before 
installation and periodically thereafter.

The installation procedure is described below. You cannot use KONA with third-party 
applications until the AJA KONA software has been installed on the host workstation.

If you add KONA supported applications at a later date and have not previously installed the 
appropriate plugins, you must run the install program again selecting the appropriate 
application support software to be installed.

Software 
Installation 
Procedure

Locate the AJA KONA Software download or CD ROM packaged with your system and follow the 
procedure below to install the required software on the host system. The KONA for PC software 
is intended for Windows 7 64-bit workstations. 

The KONA for PC 5.5.2 Installation Software is divided into the packages shown below. The AJA 
Retail Software package must be installed first. We recommend you install the AJA Machina 
Control application next, followed by your desired Application Software (Fusion and Adobe 
CS5.5 are shown here).

KONA for PC Installer Packages

Note:  Before installing KONA software, turn off any virus protection and security software that 
you have installed on your computer.
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This section describes the AJA Retail Software package installation. The subsequent 
installations are essentially the same but do not require restart of the computer.

Double click on the download package or insert the KONA CD into the PC.

Install Wizard
The KONA installation program will launch and extract the necessary KONA drivers for 
installation on the desired hard drive.

Install Wizard Welcome

When you see the Welcome page, click “Next” to view the KONA license agreement.



1

27Installation & Hardware Configuration — Installing KONA Software  

License Agreement

Read the KONA license agreement and check the Agreement box to accept. You will be asked to 
choose the type of installation you would like to perform.

Installation Type

If you don’t have all the KONA supported products installed on your workstation, you may 
choose to perform a Custom installation (default) and select only the software necessary for 
your applications. Otherwise, use the “Typical” installation. The following screens depict the 
more elaborate Custom installation.
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Custom Installation Menu 

You may deselect an Item for installation by using the pulldown to make it unavailable. 

Custom Selections Pulldown Menu
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Use the second level options choose the specific drivers and plugins you would like installed. 
Disabled selections are marked with a red X. Before clicking Next to install, you can verify your 
disk space availability by clicking the Disk Usage button.

Workstation Disk Usage Display

To return to the installation click OK. Click Next to begin the installation. screen.

Begin Driver and Plugin Installation
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When the installer has completed copying the KONA software to disk, you may see a standard 
Windows Logo test warning. Click on the “Continue Anyway” button to finish the installation.

When the installation is completed, a final screen will be displayed announcing that “Setup 
has finished installing AJA KONA on your computer.” Click on the Finish button after the 
installation is complete. The AJA Retail installation requires you restart the computer after 
installation to activate the KONA card. 

 

Restart Screen

You may now repeat this installation procedure for Machina and your chosen Application 
plugins.

Re-Installation & 
Repair

If you have problems running your newly installed pluggins or need to re-install for added 
applications, you can relaunch the install package and access the following window. 

Note:  Note: Always uninstall KONA software before installing a new version.

Change, Repair, or Remove Installation Menu 
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Chapter 3: Setup & Configuration

3

Setup Overview 

This Chapter discusses the KONA features that are common across all its plug-ins and the 
Machina application. Here you’ll find a basic overview of how KONA operates and is 
configured, from making source and format selections to capturing, previewing, and playing 
back video and audio.

Selection of Primary & Secondary Formats 

In KONA’s operation, the Primary Format is that which is written to disk. The Secondary Format 
is set to match the format of the input device (if the Primary Format is a conversion) or to 
match the format that is set for an output monitor if you’re monitoring a conversion and the 
Primary Format is the format on the input device.

Note:  The KONA Secondary Format nomenclature places (O) or (I) at the end of the signal 
format: (O) indicates the selected secondary format is for output only. (I) indicates the 
format selection is that of an input only.

The Secondary Format isn’t used if there are no conversions. In all of the applications 
supported by KONA, you can set these formats. In the Adobe applications (Premiere Pro, After 
Effects, and Photoshop), the KONA plug-ins provide similar ways of making these choices. In 
each application, though their interfaces may differ, these choices are virtually the same.

The Primary Format menu allows you to select the video format to be used in the current 
project. Analog output is always available and performs a conversion, if necessary, based on 
the Primary or Secondary Format.

Note:  No frame rate interpolation is applied for conversions from one frame rate to another.
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Primary and 
Secondary Format 
Options Supported 
by KONA cards

Primary to Secondary conversion allows you to set down-, up-, and cross-conversion 
depending on the KONA model and formats supported.

Video Signal Formats KONA LHe Plus KONA LHi KONA 3G

720x576 @ 25.00i Yes Yes Yes

720x576 (Wide) @ 25.00i Yes Yes Yes

720x486 @ 29.97i Yes Yes Yes

720x486 (Wide) @ 29.97i Yes Yes Yes

720x480 @ 29.97i Yes Yes Yes

720x480 (Wide) @ 29.97i Yes Yes Yes

1280x720 @ 23.976p Yes Yes Yes

1280x720 @24.00p Yes Yes Yes

1280x720 @ 25.00p Yes Yes Yes

1280x720 @ 29.97p Yes Yes Yes

1280x720 @ 30.00p Yes Yes Yes

1280x720 @ 50.00p Yes Yes Yes

1280x720 @ 59.94p Yes Yes Yes

1280x720 @ 60.00p Yes Yes Yes

1920x1080 @ 23.976sF Yes Yes Yes

1920x1080 @ 24.00sF Yes Yes Yes

1920x1080 @ 25.00sF Yes Yes Yes

1920x1080 @ 29.97sF Yes Yes Yes

1920x1080 @ 30.00sF Yes Yes Yes

1920x1080 @ 25.00i Yes Yes Yes

1920x1080 @ 29.97i Yes Yes Yes

1920x1080 @ 30.00i Yes Yes Yes

1920x1080@50i Yes Yes Yes

1920x1080@59.94i Yes Yes Yes

1920x1080@60i Yes Yes Yes

1920x1080 @ 23.976p Yes Yes Yes

1920x1080 @ 24.00p Yes Yes Yes

1920x1080 @ 25.00p Yes Yes Yes

1920x1080 @ 29.97p Yes Yes Yes

1920x1080 @ 30.00p Yes Yes Yes

1920x1080 @ 50.00p Yes Yes

1920x1080 @ 59.94p Yes Yes

1920x1080 @ 60.00p Yes Yes

2048x1080@23.976sF Yes

2048x1080@24.00sF Yes

2048x1080@23.976p Yes

2048x1080@24.00p Yes

2048x1556@14.98p Yes

2048x1556@15.00p Yes
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Convert Mode

Allows selection of a conversion mode for up-, down-, or cross-conversion between High-
definition and Standard-definition, or High-definition to High-definition formats. The 
choices offered depend on the KONA model present and the Primary and Secondary 
format chosen. KONA 3G and LHi models support up-, down-, and cross-conversion plus 
SD-to-SD aspect ratio conversions. LHe Plus provides down-conversion 

KONA LHi & KONA 3G Conversion Options:   

All conversions use AJA 10-bit hardware on the card. 

Primary Video Format Secondary Format Options
720x480 @ 29.97i
720x480 (Wide) @ 29.97i
720x486 @ 29.97i
720x486 (Wide) @ 29.97i

1920x1080 @ 29.97i
1280x720 @ 59.94p
720x486 @ 29.97i

720x576 @ 25.00i
720x576 (Wide) @ 25.00i

1920x1080 @ 25.00i
1280x720 @ 50.00p
720x576 @ 25.00i

1280x720 @ 23.976p 720x486 @ 29.97i
1920x1080 @ 29.97i

1280x720 @24.00p 1920x1080 @ 30.00i

1280x720 @ 25.00p 720x576 @ 25.00i
1920x1080 @ 25.00i

1280x720 @ 29.97p 720x486 @ 29.97i
1920x1080 @ 29.97i

1280x720 @ 30.00i 1920x1080 @ 30.00i

1280x720 @ 50.00p 720x576 @ 25.00i
1920x1080 @ 25.00i

1280x720 @ 59.94p 720x486 @ 29.97i
1920x1080 @ 29.97i

1280x720 @ 60.00p 1920x1080 @ 30.00i

1920x1080 @ 23.976sF 720x486 @ 29.97i

1920x1080 @ 24.00sF None Available

1920x1080 @ 25.00sF 720x576 @ 25.00i
1280x720 @ 50.00p

1920x1080 @ 29.97sF 720x486 @ 29.97i
1280x720 @ 59.94p

1920x1080 @ 30.00sF 1280x720 @ 60.00p

1920x1080 @ 25.00i 720x576 @ 25.00i
1280x720 @ 50.00p

1920x1080 @ 29.97i 720x486 @ 29.97i
1280x720 @ 59.94p

1920x1080 @ 30.00i 1280x720 @ 60.00p
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To do a down-conversion on an HD input (KONA 3G and LHi models):

• Set the Primary Format as an SD format

• Select the correct HD format with an (I) input designation for the Secondary Format, 
then

• Choose a “– Secondary” Video Input type

To do an up-conversion on an SD project for HD output (KONA 3G and LHi):

• Set the Primary Format as an SD format

• Select the correct HD format with an (O) output designation for the Secondary Format, 
then

• Choose a “– Secondary” SDI1/2 Output type and an HD Analog Output

Down-conversion display mode choices that may be available include (KONA 3G and LHi):

• Anamorphic: full-screen

• Letterbox: image is reduced with black top and bottom added to image area with the 
aspect ratio preserved

• Crop: image is cropped horizontally to fit new screen size

Up-conversion display mode choices that may be available include (KONA 3G and LHi):

• Anamorphic: full-screen

• Pillarbox 4x3

• Zoom 14x9

• Zoom Letterbox

• Zoom Wide

For Cross-conversion (KONA 3G models):

• Set the Primary Format as an HD format (what you want the input converted to)

• Select the correct input HD format with an (I) input designation for the Secondary 
Format 

 
KONA 3G cross-conversion allows you to convert from one format of HD to another, such as 
1080i @ 29.97 to 720p @ 59.94. KONA 3G does not perform 2K to HD cross-convert, but can 
display a cropped cut of the 2K on an HD monitor. In addition to HD-to-HD cross-
conversion, KONA 3G also can perform SD to SD hardware based aspect-ratio conversion for 
capture and output. This is controlled the same as all other up/down/cross-conversions. Use 
it by selecting a ‘Secondary Video Format’ that matches the ‘Primary Video Format’ and 
then specifying the conversion using the ‘Convert Mode’ control.
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KONA Format Setup Options

Video Input
Each KONA plug-in, and the stand-alone Machina application, offer a Video Input pull-down 
menu to select an appropriate signal type for your input. (The current selection is reported in 
the display of the pull-down menu.) 

Video Input always shows all the available input options based on your Primary and Secondary 
format configuration. KONA software looks at 1) what model you have, 2) Primary Format, and 3) 
Secondary Format (in that order) to determine the appropriate input options.

Video Input Options Supported by KONA cards include: 

• Single Link SDI • Component Betacam NTSC-J

• Composite NTSC • Component SMPTE NTSC-J

• S-Video NTSC • Composite PAL

• Component Betacam NTSC • S-Video PAL

• Component SMPTE NTSC • Component Betacam PAL

• Composite NTSC-J • Component SMPTE PAL

• S-Video NTSC-J • Component XVGA (HD only)

• Dual Link HD (KONA 3G only) • HSDL (KONA 3G only)

Audio Input
Use the Audio Input pull-down menu to select the appropriate signal type for your input. (The 
current selection is reported in the Status Display.)

Audio Input Options Supported by KONA cards include:

• Embedded SDI

• Digital AES/EBU - XLR

• Digital AES/EBU - BNC (only applies if you are using a KL- or K3-Box)

SDI Outputs 1 & 2
When using KONA LHe Plus and LHi cards, the SDI outputs will be Single Link only, if there is no 
Secondary Video Output Format selected. If you have a Secondary format selected, you can 
choose between Single Link SDI – Primary and Single Link SDI – Secondary as your output. 
KONA 3G also offers Dual Link output which uses both output connectors for a single A/B 
channeled output (SDI Output 2 automatically becomes Dual Link).

On KONA LHi, there is only one SDI output, but there is an HDMI output. You can independently 
configure the SDI output to HD or SD, and the HDMI input to SD or HD. The LHi has a hardware-
based downconverter, so you can output SD if desired, when playing back HD (or in E-to-E). 

Analog Output
Analog format choices in the Analog Output pull-down menu vary depending upon file format. 

• Composite + S-Video NTSC • Composite PAL

• Composite + S-Video NTSC-J • S-Video PAL

• Component Betacam NTSC • Component Betacam PAL

• Component Betacam NTSC-J • Component SMPTE PAL

• Component SMPTE • Component RGB 

• Component XVGA (HD only)
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Note:  When SD and HD formats are available as Primary and Secondary formats, you can 
choose between SD and HD raster for the Analog Output.

Audio Level
Choose between +6 dB (US) monitor level and +0 dB (EBU).

Timecode Input
Select the type of timecode used by the source video machine—RS-422, Embedded SDI 
(RP188) or choose to input an External LTC timecode source input via the KONA RS-422 port.

Note:  SMPTE RP 188 defines a standard for the transmission of time code and control code in 
the ancillary data space of a digital television data stream. Time code information is 
transmitted in the ancillary data space as defined in ANSI/SMPTE 291M. Multiple codes 
can be transmitted within a single digital video data stream. Other time information, such 
as realtime clock, DTTR tape timer information, and other user-defined information, may 
also be carried in the ancillary time code packet instead of time code. The actual 
information transmitted through the interface is identified by the coding of a distributed 
binary bit. Equipment manufacturers can use the meta data for different purposes.

Desktop Display Options
Select one of four modes of desktop display:

• Off

• Display while idle only (this mode is suggested)

• Display during capture only 

• Display Always

Display to Desktop uses system resources and could affect performance. Choose Capture 
Speed, Width, and Height as appropriate for your system capabilities.

Desktop Speed:   

• Full Speed – Every frame is displayed to desktop during playback

• Half Speed – Every other frame is displayed to desktop during playback

• Quarter Speed – one out of every four frames is displayed to the desktop

Half Speed and Quarter Speed will reduce the system load that the Display-To-Desktop is 
using to draw video to your computer. 

Desktop Capture Width and Height:    These selections allow you to reduce the 
resolution of the desktop capture display. The captured file will be full-resolution. Only the 
displayed image is reduced to save processing resources during capture. The choices 
available are:

• Full Resolution • Eighth Resolution

• Half Resolution • Sixteenth Resolution

• Quarter Resolution
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File Options 
KONA supports the following Video and Audio Formats:

Video Formats:    

• 8-bit YUV 4:2:2 – ‘2vuy’ • 8-bit RGBA 4:4:4:4 – ‘rgba’

• 8-bit YUV 4:2:2 – ‘2Vuy’ • 8-bit RGBA 4:4:4:4 – ‘bgra’

• 10-bit YUV 4:2:2 – ‘v210’ • 10-bit Log RGB 4:4:4 – ‘R10g’

• 8-bit RGB 4:4:4 – ‘rgb’ • 10-bit RGB 4:4:4 – ‘R10k’

• 8-bit RGB 4:4:4 – ‘bgr’ • 10-bit RGB 4:4:4 – ‘r10k’

• 8-bit RGBA 4:4:4:4 – ‘argb’

Audio Formats:   

• 48 kHz 16-bit PCM Mono • 48 kHz 16-bit PCM Stereo

• 48 kHz 24-bit PCM Mono • 48 kHz 24-bit PCM Stereo

• 48 kHz 32-bit PCM Mono • 48 kHz 32-bit PCM Stereo

KONA 3G supports up to 16 channels of audio (eight stereo pairs), while the other KONA cards 
support up to eight (four stereo pairs). Adobe Premiere Pro CS5.5 supports six channels.

Capture, Preview, and Playback—Differences and Similarities 

The services that KONA provides differs based on the plug-ins. Some applications, like Adobe 
Premiere when used with its KONA plug-in, offer full support for media capture, previewing from 
RAM, and playback to monitors and to an attached VTR with full machine control. Other 
applications and their KONA plug-ins offer different levels of support. This section describes the 
support provided by each KONA plug-in and the Machina standalone application and discusses 
what each of these capabilities mean.

Capture Overview Capture records the source signal to your storage system from the chosen input connector(s), 
digitizing and encoding the media (audio and video) to disk as you’ve directed in your KONA 
configuration settings. Media may be recorded directly as configured as the Primary Format 
(framebuffer) or with some type of conversion performed—a Secondary Format at the input (set 
up in KONA configuration) is converted to the Primary Format (as allowed by the KONA model you 
have).

For those applications that do not directly support capture via KONA, you can always use Machina 
to perform the capture and then load the media into the desired application as a QuickTime, AVI, 
or still image file.

Preview Overview Preview is the viewing of captured media from RAM memory in the computer. It is not necessarily 
realtime since it’s affected by CPU performance and other real world factors such as other 
activities that might be occurring on the host computer. RAM preview occurs on the computer 
monitor. The purpose of preview operations is to review the captured material and perform 
editing/trimming operations.

Playback Overview Playback differs from Preview in that the media is read directly from disk storage and output, as 
configured, to KONA outputs. Playback also outputs machine control signals to the RS422 
connector directing VTR operations. Playback is frame-accurate and suitable for broadcast and 
print-to-tape.
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Support for 
Capture, Preview 
and Playback

The following table shows for each of the KONA for PC plug-ins and the Machina application, 
which Capture, Preview, and Playback services are provided.

KONA DVCProHD Support

AJA includes a DVCProHD codec for capture and editing with the KONA card. The KONA 
installer includes Adobe Premiere Pro project presets specifically for use with DVCProHD 
compressed files. These project presets have raster sizes that match the non-standard 
resolutions and pixel aspect ratios of DVCProHD. They are especially useful when the bulk of 
the project media will be DVCProHD. 

KONA Capture DVCProHD compressed Quicktime files can be captured from HD-SDI or analog sources using 
either AJA’s Machina, or Adobe Premiere Pro CS5 (see Capture setup instructions for the 
specific application). All normal capture instructions apply except for the following:

• “File Type” must be Quicktime

• “Video Subtype” must be DVCProHD

• “Primary Video Format” should be set to the real HD raster size

For example, if capturing from a 1920x1080 source, that same raster should be selected in the 
“Primary Video Format” control in the capture settings. The encoder will automatically scale 
the video down to the appropriate DVCProHD resolution. When using KONA DVCProHD 
project presets, these settings will already be preset. 

Once capture is completed a Quicktime file will exist on the specified hard disk. If capturing in 
Adobe Premiere Pro, the Quicktime file will automatically be imported into the current 
Premiere project bin.

Application or Plug-in Capture Y/N Preview Y/N Playback Y/N Notes

Machina Y Y Y Use tabbed windows to configure

Adobe Premiere Pro CS5.5 
Plug-in

Y Y Y Capture & Preview: file-> capture
Playback: project->”project settings” 
->General->”playback settings” button

Adobe After Effects CS5.5 
Plug-in

N Y N AJA plug-in screen available under 
Windows menu

Adobe Photoshop CS5.5 
Plug-in

Y Y N Capture 1 frame: file->Import-> 
“AJA image capture”

Eyeon Fusion Plug-in N Y N Preview: file->preferences-> 
“global and new comp defaults”-> 
preview->options-> 
”display file sequences on” ->  
AJA Preview  

To Edit AJA Settings: 
file->preferences-> 
“global and new comp defaults”-> 
I/O -> AJA Preview 

Drastic Software’s 
MediaNXS LE

Y Y Y http://www.medianxs.com/ 
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For more information on using DVCProHD for:

• Compressed Online Editing,

• Compressed Offline Editing,

• Import, Editing, and Playing Multiple Media Types,

• Cross-Platform Workflow with KONA and DVCProHD

see the whitepaper DVCProHD Editing with KONA at

http://www.aja.com/pdf/AJA_whitepaper_DVCProHD_editing.pdf

AJA’s Hardware 
Scaling Support

Most AJA hardware has built in hardware-based scaling support that allows for DVCProHD 
resolution up-sampling and down-sampling to be done in real-time, with very high quality. This 
hardware-based scaling is done during capture and during playback or output from the editing 
timeline. The KONA LHi and the KONA 3G both have this support built in. 

Codec 
Requirements

The DVCProHD support included with KONA for PC requires the presence of the KONA card, and 
works only in the applications using the card. Quicktime files captured with KONA can be used 
in other applications, and even on other platforms, but they require the presence of a third party 
DVCProHD Quicktime codec like the one included in Final Cut Pro, or the standalone Quicktime 
decoder by Calibrated Software (www.calibratedsoftware.com).
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Chapter 4: Using AJA’s Machina Application 

4

Machina Capture/Playback Application 

Machina (pronounced: mock´-en-uh) is AJA’s powerful standalone capture/playback 
application that includes full VTR machine control. It is an easy-to-use interface that provides 
access to any and all KONA supported file formats, video standards, and video conversions. 
Captured files can be imported into virtually any software package that supports these file 
formats—such as 3D animation programs, audio editing programs, and more. With Machina, 
you can also accurately output files exported from these same programs to tape.

The Machina application is part of the software package that came with your KONA card. If 
you haven’t already done so, launch the KONA Install CD, follow the prompts, and click on the 
Machina short-cut placed on the desktop to launch Machina.

This chapter addresses configuration and setup unique to use of KONA LHe Plus, LHi, and 3G 
models with Machina.

KONA Realtime 
Performance

With KONA LHi running Machina, in realtime you can:

1. Capture uncompressed analog or digital SD and HD, component/composite, or S-
Video to: DPX, Cineon, Tiff, Targa, Bitmap, Quicktime, AVI, or YUV

2. Down-convert from HD to SD during capture or playback
3. Playback to two displays simultaneously, SD-SDI and analog

With KONA LHe Plus running Machina, in realtime you can:

1. Capture uncompressed analog or digital SD and HD, component/composite, or S-
Video to: DPX, Cineon, Tiff, Targa, Bitmap, Quicktime, AVI, or YUV

2. Down-convert from HD to SD during capture or playback
Playback to three displays simultaneously, SD/HD SDI and analog

With KONA 3G running Machina, in realtime you can:

1. Capture Uncompressed digital SD or HD via SDI or Dual Link to: DPX, Cineon, Tiff, Targa, 
Bitmap, Quicktime, AVI, or YUV

2. Up-convert SD to HD, Cross-convert 1080i <-> 720p, and Down-convert SD to HD 
during capture or playback

3. Display to three monitors with various conversions

Note:  AJA KONA now includes a codec for capture and editing compressed DVCProHD. See 
“KONA DVCProHD Support” on page 38 
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Machina Overview AJA’s Machina provides three tabbed windows that perform the following:

• Setup – set Activation, Capture, Playback, Device Control, and General options

• Capture – set Capture file and Clip options and Control the capture

• Play – set Playback file options and Control the playback

Machina Application Interface – Setup Menu

This section of the manual will discuss each of these windows in detail and discuss how 
various Pull-down menu options, hot-text entry fields, and play/record controls function 
and interact. 

Note:  The specific options available to you are determined by the currently active AJA 
capture device model installed in your workstation. This section will describe all 
possible options for Machina and note any options exclusive to KONA. 

Shortcuts and 
Display Features

Keyboard Shortcuts
Space Bar – Use it to start and stop playback of media. Pressing the Space Bar starts 
playback from the location of the Edit Line.

I key – press to set an In-point when trimming a clip.

J key – press to shuttle backward through the clip. Press repeatedly to move at a faster rate 
(2x, 4x, etc.).

K key – press to stop playback at the current position.
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L key – press to shuttle forward through the clip. Press repeatedly to move at a faster rate (2x, 4x, 
etc.).

O key – press to set an Out-point when trimming a clip in Machina.

Left Arrow key (<-) – press to move one frame backward.

Right Arrow key (->) – press to move one frame forward.

Up Arrow key – press to start playback (forward). 

Down Arrow key – press to start playback backward. 

Full-screen Desktop 
Display 

To use Machina for full-screen preview during capture or playback, first maximize the Machina 
window, then hit the Escape key. This can be especially useful for monitoring capture or 
playback in the absence of a full-resolution monitor. In full-screen mode you can use the mouse 
to control picture position and zoom for detail monitoring of graphic elements or frame-cut 
results (see “Display Sizes” on page 52 in this section).

Setup Window 

To configure the Machina operation, click on the Setup tab at the top of the window. In the left-
most column are the Activation Options. The next column will toggle between Capture and 
Playback options when you click on the arrow tabs to the left and right of the header text. Next, 
Device Options address machine control settings. Finally, General Options establish paths to file 
storage directories for Video and Audio files and enable other options.

Activation Options

Board

Note:  The term Board in this case refers to the AJA capture 
device being controlled by an application. In this section 
you will find the terms “board,” “card,” or “capture device” 
used interchangeably.

The Board window/menu reports the current Type of AJA 
capture device (Io Express or KONA card) selected.

Note:   Using multiple AJA capture devices in the same 
workstation is possible but not always practical due to 
motherboard and disk system bandwidth limitations.

Activation Mode
Machina and KONA plugins in Adobe applications can be set for Automatic or Manual activation 
using the Activation Mode pull-down menu. Automatic is the default setting and is 
recommended for normal operation. Current activation status is reported below the pull-down 
menu. 

The KONA card can be accessed by multiple application client windows but only one can have 
control at a time (for example, Adobe Premiere Pro and Adobe Photoshop). In automatic mode, 
an application or plugin can take active control when the KONA card is not being used. When 
the controlling application is done (and any processing initiated is complete), control is 
released, making the KONA card available to others. 
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Note:   If the application window you click on does not access KONA (reporting KONA Status: 
Active), either another application window is still processing operations or it is set in 
Manual activation mode. (Remember: only one client window can have control of the 
KONA card at a time.) If it is controlled by an application in Manual mode, you must either 
un-check the enable check-box or select Auto in the Activation Mode pull-down menu to 
relinquish control.

In Manual mode, you must click on the enable check-box to activate board-control.

KONA Information
At the bottom of the Machina Setup screen, in the left hand column, you’ll find vital 
information about your specific KONA card —license type, serial number, and version. This 
information will be helpful if you ever need technical support.

Capture Options To the right of “Activation Options “there is a column 
that can toggle to either “Capture Options” or “Play 
Options.” The arrow buttons on either side of the 
Capture Options/Play Options button determine which 
of the two is displayed. Under Capture Options, you can 
select the appropriate formats and settings for your 
project. 

The Primary Format menu allows you to select the video 
format used in your current project. The Secondary 
Video Format allows KONA to perform up-, down-, and 
cross-conversion of input or output video (as supported 
by your KONA model).

Analog output is always available.

Primary and Secondary Video Options Sup-
ported by KONA 
See “Selection of Primary & Secondary Formats ” on 
page 31 for Primary/Secondary video format and 
conversion information.

Note:  No frame rate interpolation is applied for 
conversions from one frame rate to another.

Throughout Machina, choices are always presented 
based on which KONA card you are using and what it 
can do with the signals available and the inputs/
outputs selected. For example, the LHi and KONA 3G 
cards offer up-, down-, and cross-conversion for 
supported formats. KONA LHe Plus does HD to SD 
down-conversion only.

YUV<->RGB Range
This control mode should almost never be changed from its CGR default. This setting is only 
for highly-knowledgeable users that must define how color values will be mapped when 
doing the color space conversion—far less than 1% of all users should ever need to use it. Use 
this feature only for capturing YUV source into an RGB file, or to play an RGB file out to YUV. 
The CGR setting maps the typical YUV values to typical RGB values. For example, 8bit YUV 16 is 
mapped to 8 bit RGB 0, and YUV 235 to RGB 255. The ‘SMPTE’ setting for this control maps YUV 
into RGB using the exact YUV values. Therefore, 8 bit YUV 16 will map to RGB 16, and so forth. 
Only change this setting from its default if you are absolutely sure you know the benefits/
consequences. This feature is not the same as a broadcast safe limiter.
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Video Input
Use the Video Input pull-down menu to select the appropriate signal type of your input. (The 
current selection is reported in the display of the pull-down menu.) 

Video Input always shows all the available input options based on your Primary and Secondary 
format configuration. KONA software looks at 1) what model you have, 2) Primary Format, and 3) 
Secondary Format (in that order) to determine what input options are appropriate.

Video Input Options supported by KONA cards include: 

• Single Link SDI • Component Betacam NTSC-J

• Composite NTSC • Component SMPTE NTSC-J

• S-Video NTSC • Composite PAL

• Component Betacam NTSC • S-Video PAL

• Component SMPTE NTSC • Component Betacam PAL

• Composite NTSC-J • Component SMPTE PAL

• S-Video NTSC-J • Component XVGA (HD only)

• Dual Link 4:4:4 HD-SDI (KONA 3G only) • HSDL (KONA 3G only)

Audio Input
Use the Audio Input pull-down menu to select the appropriate signal type for your input. (The 
current selection is reported in the Status Display.)

Audio Input Options Supported by KONA cards include:

• Embedded SDI

• Digital AES/EBU - XLR (using either breakout cable or breakout box)

• Digital AES/EBU - BNC (only applies if you are using KONA 3G or a breakout box with BNC 
connectors for AES/EBU) 

• Analog (KONA 3G requires K3G-Box)

SDI Outputs 1 & 2
The SDI outputs will be Single Link, Dual Link (available with KONA 3G card only), or Video+Key 
(also only available with KONA 3G card). If you have assigned a Secondary Video Format, you can 
select either the Primary or Secondary format for the SDI Output:

• Single Link SDI – Primary

• Single Link SDI – Secondary

• Dual Link SDI – Primary (KONA 3G model only)

• Dual Link SDI – Secondary (KONA 3G model only)
 
On KONA LHi, there is only one SDI output, but there is an HDMI output. You can independently 
configure the SDI output to HD or SD, and the HDMI input to SD or HD. The LHi has a hardware-
based downconverter, so you can output SD if desired, when playing back HD (or in E-to-E). 

On KONA 3G, the two SDI outputs can also be configured to output a Video signal on one SDI 
output and a Key video signal on the second SDI output for use with external devices that 
support separate video and key (switchers, DVEs, etc.). This feature is also available on the 
output settings in After Effects CS5, and Photoshop CS5. To configure separate video and key, 
set the SDI-1 Output to ‘Video + Key (V)’ or ‘Video + Key (K)’. The SDI-2 output will then 
automatically change to the complimentary setting. Video + Key is limited to 8 bit RGBA files.
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Analog Output
Analog format choices in the Analog Output pull-down menu vary with selected file format.

Analog Output Options Supported by KONA cards include:

• Composite + S-Video NTSC • Composite PAL

• Composite + S-Video NTSC-J • S-Video PAL

• Component Betacam NTSC • Component Betacam PAL

• Component Betacam NTSC-J • Component SMPTE PAL

• Component SMPTE • Component RGB

• Component XVGA (HD only)

Timecode Input
Select the type of timecode used by the source video machine — RS-422, Embedded SDI 
(RP188) or choose to input an External LTC timecode source input via the KONA RS-422 port.

Note:  SMPTE RP 188 defines a standard for the transmission of timecode and control code in 
the ancillary data space of a digital television data stream. Timecode information is 
transmitted in the ancillary data space as defined in ANSI/SMPTE 291M. Multiple codes 
can be transmitted within a single digital video data stream. Other time information, such 
as real time clock, DTTR tape timer information, and other user-defined information, may 
also be carried in the ancillary timecode packet instead of timecode. The actual 
information transmitted through the interface is identified by the coding of a distributed 
binary bit. Equipment manufacturers can use the meta data for different purposes. After 
configuring Machina Capture Options, select the Play options by clicking on the toggle 
arrows on either side of the Capture Options title header.

Play Options Primary Format, and Output Type settings are all the same for playback mode as those 
described previously. Refer to “Capture Options” on page 44.

Audio Sync
Choose to sync audio output to either the Primary Format or the Secondary format if it is 
available. When a Primary/Secondary conversion is done, there may be a 0.5 or 1 frame delay 
introduced. Audio Sync will ensure that either the Primary or Secondary format is kept in sync.

Audio Sample Rate
KONA cards support 48 kHz.

Timebase
Use the Timebase pull-down menu to choose between:

• Frames • Timecode (NDF)

•  Timecode (DF) • Reference

Using the Reference pull-down menu, select timing Reference source — Free Run, from 
External (genlock), or from the video Input signal.
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Device Control 
Options

Device Control Options set options for the RS-422 machine control interface on the KONA card. 
These functions support Print-to-Tape machine control.

Machina Device Control Options

Timecode Format
Use this pull-down to select the timecode base supported by your VTR.

• Base 24

• Base 25

• Base 25 (50 frames per second)

• Base 30 DF (drop-frame, 30 frames per second)

• Base 30 NDF (non-drop-frame, 30 frames per second)

• Base 30 DF (drop-frame, 60 frames per second)

• Base 30 NDF (non-drop-frame, 60 frames per second)
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Timecode Source
Choose between a separate-channel Longitudinal Timecode (LTC) or Vertical Interval 
Timecode (VITC) transported in the video signal’s vertical interval or include both (LTC + VITC).

Click on the Hot Text items to enter a value for:

• Preroll – 0 to 15; the number of frames required to start the source machine before 
capture

• Handles – 0 to 60; the number of frames added to the front and back of a sequence for 
editing flexibility

• Timecode Offset– -30 to +30; timecode adjustment (in frames) forward or back to 
compensate for discrepancies between the source’s burned-in timecode and that of the 
captured sequence. 

General Options Video/Audio Directory Setup
Use these hot text fields to enter the path of the default 
capture/playback directories.

Enforce Memory Alignment
For almost all cases this checkbox should remain 
unchecked. However on certain types of RAID Controllers 
(usually RAID5 SATA), when reading or writing to disc, 
 to or from system memory, memory alignment must be 
done on a 512-byte address alignment. Enabling this 
option insures that reading/writing is done to a 512-byte 
address in system memory. But there is a performance 
cost. Due to re-alignment, reading/writing is not 
guaranteed to be in realtime. 

Audio Files Setup
Three audio enable check boxes, when checked, allow you 
to:

• Enable Audio Scrubbing – Audio will play while you move through frames using the 
scrub bar (see Play Controls).

• Enable Audio Variable Speed – Audio will play at the same speed the video is played 
(rather than 1x only).

• Enable Audio Auto-Search – KONA software will automatically load the Audio Track list 
with audio files that have been generated with the same name as the selected video file. 

Note:  When Audio Auto-Search is active, existing file names in the list will be removed or 
over-written when the Video File is loaded. (Does not affect the actual audio files.)

Audio Monitor Levels
Choose between +6 dB (US) monitor level and +0 dB (EBU).
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Capture Window 

Click on the Capture tab to bring up the Capture window. The figure below shows the Clip 
Options panel. Also available by clicking on the hot toggle buttons left and right of the title 
header are File Options and Display Options and Overlay Options.

Machina Capture Window
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File Options In the File Options menu you will configure the capture file 
you will be creating by setting the following.

Type 
The Type pull-down menu provides a choice of video/audio 
file formats:

• QuickTime Movie

• TGA Sequence

• AVI Movie

• BMP Sequence

• DPX Sequence (KONA 3G & LHi only)

• TIF Sequence

• Cineon (KONA 3 & LHi only)

• YUV Sequence

Video/Audio 
Use this pull-down menu to select the video/audio input combination you will capture:

• Video Only

• Audio Only

• Video – (minus) Audio – video and audio are recorded in separate files

• Video + (plus) Audio (QuickTime only) – video and audio are recorded in the same file

The options shown are determined by the selected file format. QuickTime captured audio is 
either embedded with the video file or captured to separate .mov files. All other formats 
capture audio to Wave Files.

Video Subtype
Video Capture Formats supported by KONA cards (varying according to file type) include:

• 8-bit YUV 4:2:2 – ‘2vuy’ • 8-bit RGBA 4:4:4:4 – ‘rgba’

• 8-bit YUV 4:2:2 – ‘2Vuy’ • 8-bit RGBA 4:4:4:4 – ‘bgra’

• 10-bit YUV 4:2:2 – ‘v210’ • 10-bit Log RGB 4:4:4 – ‘R10g’

• 8-bit RGB 4:4:4 – ‘rgb’ • 10-bit RGB 4:4:4 – ‘R10k’

• 8-bit RGB 4:4:4 – ‘bgr’ • 10-bit RGB 4:4:4 – ‘r10k’

• 8-bit RGBA 4:4:4:4 – ‘argb’

Audio Subtype 
Audio Capture Formats supported by KONA cards include:.

• 48 kHz 16-bit PCM Mono • 48 kHz 16-bit PCM Stereo

• 48 kHz 24-bit PCM Mono • 48 kHz 24-bit PCM Stereo

• 48 kHz 32-bit PCM Mono • 48 kHz 32-bit PCM Stereo
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Audio Track
Select the number of audio tracks for this project. KONA models support up to 16 tracks 
depending on the Model. 

Clip Options Clip Name
In the Clip Options menu, click on the Clip Name to name the 
file you will be creating. Subsequent file numbers will 
increment from this one. 

Reel Name 
Click on the hot text field to enter a source tape name—the 
name of the tape on the VTR. Only QuickTime and DPX files 
store this information.

Sequence Offset
When capturing file-per-frame sequences, after naming a file, 
you can set a Sequence Offset number that will determine 
the beginning number of the file sequence. 

Create New Folder Per Sequence 
 A check-box is provided to enable this automatic function. When you check this selection, 
Machina will gather each frame capture sequence in a new folder, based on clip names, on your 
disk. (Not applicable to QuickTime or AVI movie files.)

Abort on Dropped Frames
Checking this box causes a capture to automatically stop any time that KONA detects frames are 
being dropped for some reason. This ensures you don’t waste storage space and time capturing 
when there may be a problem with the capture. 

Display Options Display Options configure how the desktop display operates for capture.

Display Type
The Display Type pull-down menu provides a choice of display 
rendering formats: OpenGL Texture or OpenGL DrawPixels. This 
setting changes the way the PC’s GPU handles video overlay on 
your desktop monitor. OpenGL Texture should always be used 
whenever possible. Note, however that this setting is not 
guaranteed to work on all boards. It has been tested primarily 
with high-end nVidia workstation graphics cards. Using OpenGL 
Texture mode will allow any applied LUTs to be displayed on the 
desktop display as well as on the video output.

Open GL DrawPixels should only be used when you are 
experiencing display problems. Typically, this will be for 
graphics cards that are not AJA approved, and that have less 
OpenGL support. This mode does not allow applied LUTs to be 
displayed on the desktop. This mode also has many limitations 
when working with YUV files. When using this setting, files may appear pixelated on the desktop 
display. This does not affect the quality or resolution of the video being captured or output from 
the KONA card.
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Display To Desktop
This setting determines when the desktop monitor overlay is present. Choice include:

• OFF – always off (no display)

• While Idle Only – displays whatever is present at the selected input while idle; when 
capturing, there is no display (saving system resources)

• While Capture Only – only display while capturing

• Always – display during capture and when idle

Display Sizes
The desktop monitor display will be sized according to this setting. You can choose from 
select sizes (25% to 800%), enter a custom size (Custom), or have KONA fit the display size 
according to your Machina screen (Fit). If you use Custom, use the hot text fields underneath 
Display Sizes to enter a specific percentage and X and Y origin points.

You can also zoom picture size by clicking on the Size hot text field and dragging to the left or 
right. Zoom can also be done using the scroll-wheel of your mouse (especially helpful when 
viewing the display in Full-screen mode, see “Shortcuts and Display Features” on page 42). To 
move the picture within the display, just click in the display area and drag the picture.

Overlay Options The final options selection in the Capture window is Overlay Options. These overlay controls 
allow you to insert a graphic file supporting alpha channel transparency to apply an effect or 
insert a bug (logo) over the video content.

Enable Overlay
Enable/disable the overlay using this checkbox.

Mixer Coefficient
Adjust the overlay file transparency (range: 0 to 1000). 
Double-click on the field to select and enter a value or 
click-drag left or right to increment or decrement 
(respectively).

Foreground Video 
Select the blending mode for the foreground layer:

• Full Image 

• Pre-Mult Alpha 

• UnShaped 

Background Video
Select the blending mode of the background layer.

Graphic File 
Click in the text entry field to browse for the overlay file you want to use. Click on the trash can 
to the left to delete the current selection.
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Use as Background Video
Check this box to place the Graphic File on the Background layer and place the motion video in 
the foreground layer.

Capture Controls Standard tape deck icons provide hot buttons for the Capture process. They are:

The slider on the bottom is a variable speed forward/reverse control. Positions from left to right 
are: (Reverse) 16x, 8x, 4x, 2x, 1/2, 1/4, Still, (Forward) 1/4, 1/2, 2x, 4x, 8x, and 16x.

The red button is for Record.

Machina Capture Controls

The toggle buttons on the top-left step through one of three capture modes:

• Capture Now – manual record/stop (“crash”) capture

• Capture Duration – capture a specified number of frames after manual start, based on the 
timebase of the selected Primary Format

• Capture In/Out – initiate and end capture using timecode-based in and out settings

The selected mode will activate the appropriate hot text for that mode (to the right of the 
Capture Mode selection). Click the hot text to enter a timecode value 
(hours:minutes:seconds:frames). The bottom display indicates the current machine status and 
timecode from the VTR.

Rewind (8x) Fast Forward (8x)

Reverse Play Reverse 1 frame

Still Stop

Play (1x) Forward 1 frame

Capture Mode

VTR Status

KONA StatusCapture Time Entry Fields
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Capture In/Out Mode
The capture in-point is entered by clicking on the left field of eight digits. The out-point can 
be set by clicking on the right field of eight digits. Alternatively, you can specify a duration in 
the Duration field and the in- or out-point (whichever you have not entered) will be entered 
automatically according to duration.

Note:  The in-point/out-point field values are inclusive. If both are set to the same value, the 
capture duration will be 1 frame.

To load the current VTR timecode setting in either field (in-point or out-point) click on the hot 
text field and enter from your keyboard. 

Note:  When a hot text field has a dotted underline, you can left-click and hold on the field 
and drag your curser to increment or decrement the value.

VTR TC
The current VTR timecode is displayed on the bottom of the control pane and you can click on 
it and enter a timecode to perform a seek to that timecode on the VTR. The VTR must be 
online and in remote rather than local control mode (as reported to the left of the current 
timecode). 

Capture/KONA Status
Click on the hot toggle buttons of the Status header to switch between Capture Status and 
KONA Status. Capture Status reports current state of activity, capture duration and number of 
frames captured in ( ), and the number of frames that may have been dropped.

KONA Status reports Active/Inactive status, Primary Format setting, Video Input type, and 
Audio Input type.
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Play Window 

Machina Play Screen

File Options On the right side of the desktop display, you can use the hot buttons at the top to toggle 
between File Options, Display Options, and Leader/Trailer Options. In File Options, the current 
file name and path is loaded into the Video field. Alternatively, you can click on the path hot text 
to select a file, delete it using the trash icon at the left, or turn it on/off using the check-box at 
the right.

Format, Colorspace, and total number of frames in the file is reported below the path text.

You can preview the effects of a color Look Up Table by clicking on the LUT hot text or delete the 
selected LUT file by clicking on the trash icon.

You can edit the Audio Track list that is automatically loaded with audio files that have been 
generated with the same name as the selected video file. QuickTime embedded audio files are 
automatically appended with a number and will be loaded numerically into the track list. Click 
on the trash icon to delete a track. Click on the check-box on the right to enable/disable a track. 
To manually enter audio files, simply double-click on a track in the list.
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Display Options In the Display Options menu you will configure how the desktop display operates during 
playback operations. 

Display Type 
The Display Type pull-down menu provides a choice of display rendering formats: OpenGL 
Texture or OpenGL DrawPixels. This setting changes the way the PC’s GPU handles video 
overlay on your desktop monitor. OpenGL Texture should be used whenever possible. These 
options were described in detail earlier under the Capture screen options.

Display To Desktop
This setting determines when the desktop monitor overlay is present. Choice include:

• OFF – always off (no display during scrubbing or playback)

• While Scrubbing Only – displays media as you scrub through it via the playhead; during 
playback there is no display (saving system resources)

• While Playing Only – displays media only during playback

• Always – display during playback and when idle

Display Sizes
The desktop monitor display will be sized according to this setting. You can choose from 
select sizes (25% to 800%), enter a custom size (“Custom”), or have KONA fit the display size 
according to your Machina screen (“Fit”). If “Custom” is chosen, use the hot text fields 
underneath Display Sizes to enter a specific percentage and/or X and Y origin.

Leader/Trailer 
Options

Leader/Trailer Options allow you to add colorbars, test tone, and black field in a leader to your 
clip and black field as trailer. Note that the dotted underline indicates that you can left-click 
down and scroll the mouse to increment/decrement these values.

Leader/Trailer Options
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Play Controls There are two modes of play control—one for Edit and one for Output. Click the hot buttons at 
the top-left of the pane to toggle between the two modes. 

Edit Mode – In Edit mode, immediately under the mode toggle buttons are standard tape deck 
icons providing hot buttons for the Play process. They are: 

Edit Mode Play Controls and Scrub Bar 

Below the Play buttons is a Scrub Bar that allows you to click and drag along the loaded 
sequence to view individual frames and mark In/Out- points for playback of frame subsets. To 
set an in-point, click on the left bracket. To set an out-point, click on the right bracket.

To set an in-point, click on the left-most hot text numeral below the bar and enter the desired 
frame number. Similarly, enter the out-point by clicking on the right side hot text numeral.

Note:  The “first” or “last” frame may be for the entire sequence or for frames in an in/out-
marked subset. In this case, first, last, in, and out frames become “Most Significant Frames.” 
For example, clicking on the Go-to-1st button will move you to the first Most Significant 
Frame to the left. Clicking on the Go-to-Next button will move you to the first Most 
Significant Frame to the right. 

The slider on the bottom is a variable speed forward/reverse control. Positions from left to right 
are: (Reverse) 16x, 8x, 4x, 2x, 1/2, 1/4, Still, (Forward) 1/4, 1/2, 2x, 4x, 8x, and 16x.

Go-to-Previous “Most Significant” frame Reverse 1 frame

Rewind (8x) Reverse Play

Still Stop

Play (1x) Fast Forward (8x)

Forward 1 frame Go-to-next “Most Significant” frame

Play Entire Clip or Marked Segment

Play Mode Arrow
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Play Modes
Select a Play type by clicking the Play hot toggle buttons above the controls. Choose 
between: Play All or Play Range. 

You can select one of three Play Modes by clicking on the Play Mode arrow to the left of the 
slider control. You will step through the following modes:

• Once (single arrow) – play once through in forward or reverse

• Bounce (double-ended arrow) – play continuously, alternating between forward and 
reverse play

• Loop (double right-pointing arrow) – play repeatedly, looping in one direction

If you have designated an In/Out sub-segment you can use the hot text brackets (to the right 
of the Play Mode arrow) to play either the entire clip [ ] or the marked segment  
only { }.

Output Modes Toggle the Play Mode to Output and standard VTR controls and machine control timecode 
hot text will appear. Beneath the Output mode header are hot-buttons that allow you to 
choose between two modes of output—Insert Edit or Print-To-Video. Print-To-Video and 
Insert Edit will output the loaded clip from its in/out- points (if any exist) or from the first to 
last frame (if no in/out-points have been set).

Play Controls for Insert Edit

Insert Edit
In this mode, you can select the Video/Audio content that you want to insert by checking the 
desired content boxes at the left. Then set an in-point that the recording VTR will use to 
initiate recording of your segment. Duration is determined by the length of the clip you are 
outputting.

Note:  The Preview Edit check-box controls whether the insert edit is in “Preview” mode or 
not. In preview mode, the deck never goes into record but just simulates the edit without 
putting anything to tape. You must un-check this box to perform the actual Insert Edit.
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Print-to-Video Mode
This mode allows you to manually put a clip to tape using the VTR’s current position. You have 
the option of adding Delay frames. KONA will wait this many frames after the tape machine’s 
start command, before it outputs the clip. The Duration Field displays the total length of the clip 
that will go to tape. Click on the green hot button to launch the output sequence.

Play Controls for Print-to-Video

Assemble Edit Procedure
Assemble Edit features exist in both Machina and the AJA capture Plug-in for Premiere Pro. 
These features create a two step process for Assemble Editing. The procedure require the tape 
to have at least a few seconds of timecode already on it. If it does not have any timecode, a small 
segment near the front of the tape must be blackened to provide this initial timecode. This 
procedure assumes you are using a blank tape:

1. Blacken the Tape – This must be done in Machina

a Insert the tape and be sure it is cued to the right location

b Verify that the video cables and RS422 are connected correctly

c In the lower left hand corner of the “Play” tab in Machina, set the “Edit/Output” toggle to 
“Output”.

Blacken Tape Mode

d Next set the toggle button below, to “Blacken Tape”

e In the timecode clock to the immediate right of the toggle buttons, enter your desired 
beginning timecode

f Click the green “Record” button and allow the deck to blacken about 30 seconds of the 
tape
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2. Punch-In Assemble (This can be performed either in Machina or Premiere Pro)

a Cue the tape to a location where there is timecode

b Set the edit toggle to “Punch-In Assemble”

Punch-in Assemble Mode

c Specify the timecode where you would like the “Punch-In” to begin

d Set the timecode generation setting on your deck to “regen”

e Click the record button to begin the assemble edit.

Play/KONA Status
Click on the hot toggle buttons of the Status header to switch between Play Status and  
KONA Board Status. Play Status reports current state of activity, play duration selected for the 
current playback, total number of frames in ( ), and lastly, the number of frames that may have 
been dropped. KONA Status reports Active/Inactive status, Primary Format setting, Video 
Input type, and Audio Input type.
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Chapter 5: Using Adobe CS5.5 Applications 

5

Overview 

There are KONA plugins for both Mac and Windows versions of the Adobe Applications and 
functions are virtually the same. This chapter will describe the Windows menus and note 
exceptions.

AJA Software for KONA is tightly integrated with Adobe Premiere Pro CS5.5, Photoshop, and 
After Effects (not included with KONA). KONA allows a user to bring in supported Premiere Pro 
CS5 compressed formats and provides plug-ins and drivers that add functionality to the 
Premiere Pro application. 

Note:  You should have Adobe CS5 applications installed on your workstation before 
installing KONA software. The KONA installation adds required files to your Adobe 
application directories. Also, CS5 pluggins for Mac come in a separate installer that must 
be run along with the standard KONA for Mac installer. See KONA downloads at:

http://www.aja.com/support/index.php

After you install the KONA software on your workstation, all you need to do to begin using it is 
to become familiar with the AJA plugins and how Adobe CS5 applications access  
KONA options. 

The manual you are reading does not provide operational information for Adobe CS5 except 
as related to KONA operations. Please read the Adobe Premiere Pro, Photoshop, and After 
Effects CS5 user documentation for information on configuration and operation. 

Note:  AJA Windows Software operates on both AJA KONA cards and Io Express at different 
functional levels. Some setup screens may use either KONA or Io Express interchangeably 
when referring to your AJA capture hardware.

The chapter you are reading addresses configuration and setups supported by KONA. Topics 
covered include:

• Adobe Premiere Pro Realtime Performance

• Beginning a Project with KONA Presets

• KONA Capture Options

• KONA Playback Options

• Using Adobe Photoshop CS5

• Using After Effects CS5.5
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Adobe Premiere Pro Realtime Performance 

With KONA, Adobe Premiere Pro CS5.5 can perform the following functions in Realtime:

• KONA LHe Plus can capture uncompressed analog or digital SD and HD, component or 
composite, or S-Video to the supported file formats. 

• KONA LHi can capture uncompressed analog or digital SD and HD,HDMI, component 
or composite, or S-Video to the supported file formats. 

• KONA 3G can capture uncompressed digital SD or HD via SDI or Dual Link and 
uncompressed digital 2K via HSDL at 15 fps to the supported file formats.

• Playback of DPX, Cineon, Tiff, Targa, BMP, Quicktime, AVI, YUV, and HDV MPEG.

Note:  This happens automatically. Files of these types that match the resolution and frame 
rates of the projects will play in realtime as long as they are uncompressed and in one 
of the supported colorspaces. The exception is HDV, which of course is compressed. For 
HDV to playback RT it must be in a 1080 project and the frame rate or the file must 
match that of the project.

• Crop – happens automatically when an imported file is too large for the project size. 
Using Premiere Pro’s Motion Effects positioning, this realtime crop is keyframable 
(Timeline Option “Render RT files of different resolution” box must be unchecked). 
This also occurs when you use the Adobe Crop effects which can be found in the 
effects folders under Transform.

• Up/Down/Cross Convert the playback from the timeline. (Cross- and up-convert are 
supported by the KONA 3G, and LHi cards only.)
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Beginning a Project with KONA Presets 

Opening Adobe Premiere Pro CS5.5, you will select New Project from the Quick Start Screen and 
choose an AJA Capture Format from the pulldown menu, name the project, and click OK to 
access the New Sequence setup panel with presets or click the AJA Setup button to customize 
your workflow in the Capture Options panel “Capture Options” on page 68.

KONA Adobe Premiere Pro CS5.5 New Project panel
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New Sequence Setup Panel

Using the New Sequence Setup panel, you can select from AJA Presets. The KONA Presets 
offer typical project settings.

The Description field summarizes the parameters for each preset including:

• Frame raster size • Timebase

• Frame rate • Pixel Aspect Ratio

• Field order • Audio sample rate

• Capture file format • Video Rendering format

• Sequence settings

You can adjust the preset Capture setting by going to Project>Project Settings>General to 
access the AJA Setup menu. See “Capture Options” on page 68..

Options Set in 
Premiere Pro 
Preferences

Some settings that determine both capture and playback characteristics for KONA are 
accessed through Premiere Pro Preferences.
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In Adobe Premiere Pro CS5.5 Preferences (under Edit>Preferences) you can set up global 
(default) settings for:

• Audio Hardware

• Audio Output mapping

• Device Control

Audio Hardware
Select “Premiere Pro WDM Sound” from the pull-down menu for your audio hardware. If you see 
“KONA ASIO” do not select it for use with KONA.

Audio Hardware Preferences
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Device Control
Device Control Options are settings for the RS-422 machine control interface on KONA. 

Always us the AJA Serial Control and the KONA RS-422 port for KONA capture

Edit>Preferences>Device Control>Options

Enter the desired value for:

Preroll – 0 to 15; the number of frames required to start the source machine before 
capture.
Timecode Offset –  -30 to +30; timecode adjustment (in frames) forward or back to 
compensate for discrepancies between the source’s burned-in timecode and that of 
the captured sequence.

Click on the Options button to pull up the AJA Device Control window.

Timecode Format – Use this pull-down to select the timecode base supported by your VTR.

• Base 24

• Base 25

• Base 25 NDF (50 frames per second)

• Base 30 DF (30 frames per second)

• Base 30 NDF (30 frames per second)

• Base 30 DF (60 frames per second)

• Base 30 NDF (60 frames per second)
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The timecode format is used for both monitoring the RP-188 timecode embedded in the digital 
data stream and for selecting a timecode offset (if required) for the attached VTR (connected to 
KONA’s RS-422 port).

Timecode Source
Choose between a separate-channel Longitudinal Timecode (LTC) or Vertical Interval Timecode 
(VITC) transported in the video signal’s vertical interval or include both (LTC + VITC).

Premiere Pro Capture Options Panel

Using the Capture Options panel you can change or adjust details for the selected Preset. The 
following settings can be accessed:

• Capture Options – change Capture Format for the Adobe Premiere Pro CS5.5 project and 
access settings for KONA Capture. 

• Desktop display options

• File video/audio formatting options

AJA Capture Options panel
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Capture Options Under Capture Options, select the appropriate formats and settings for your project. 

Primary and Secondary Video Options Supported by KONA 
In KONA operation, the Primary Format is the captured media format written to disk—the 
video format used in your current project. Secondary format is used to perform up-, down-, 
and cross-conversion of the input or output video. Selections vary according to the particular 
Primary format used.

Analog output is always available.

Note:  No frame-rate interpolation is applied for conversions from on frame-rate to another.

See “Selection of Primary & Secondary Formats ” on page 31. for more video format and 
conversion information.

YUV<->RGB Range
This control mode is not often used in most workflows. For information refer to “YUV<->RGB 
Range” on page 44.

Video Input
Use the Video Input pull-down menu to select the appropriate signal type of your input. (The 
current selection is reported in the display of the pull-down menu.) 

Video Input always shows all the available input options based on your Primary and 
Secondary format configuration. KONA software looks at 1) what model you have, 2) Primary 
Format, and 3) Secondary Format (in that order) to determine what input options are 
appropriate. Video Input Options Supported by KONA cards include: 

• Single Link SDI• • Component Betacam NTSC-J

•  Composite NTSC• • Component SMPTE NTSC-J

•  S-Video NTSC• • Composite PAL

• Component Betacam NTSC• • S-Video PAL

• Component SMPTE NTSC• • Component Betacam PAL

• Composite NTSC-J• • Component SMPTE PAL

• S-Video NTSC-J• • Component XVGA (HD only)

• Dual Link HD (KONA 3G only)• • HSDL (KONA 3G only)

Audio Input
Use the Audio Input pull-down menu to select the appropriate signal type for your input. (The 
current selection is reported in the Status Display.)

Audio Input Options Supported by KONA include:

• Embedded SDI 

• Digital AES/EBU – XLR (using either breakout cable or breakout box, except on KONA 3G)

• Digital AES/EBU – BNC (only applies if you are using a breakout box with BNC connectors 
for AES/EBU) 

• Analog (KONA 3G requires K3G-Box)
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SDI Output 1 
When using KONA LS and LHi cards, the SDI outputs will be Single Link only, if there is no 
Secondary Video Output Format selected. If you have a Secondary format selected, you can 
choose between Single Link SDI – Primary and Single Link SDI – Secondary as your output. 
KONA 3G also offers Dual Link output which uses both output connectors for a single A/B 
channeled output (SDI Output 2 automatically becomes Dual Link).

On KONA LHi, there is only one SDI output, but there is an HDMI output. You can independently 
configure the SDI output to HD or SD, and the HDMI input to SD or HD. The LHi has a hardware-
based downconverter, so you can output SD if desired, when playing back HD (or in E-to-E). 

Analog Output
Analog format choices in the Analog Output pull-down menu vary depending upon file format. 

• Composite + S-Video NTSC• • Composite PAL

• Composite + S-Video NTSC-J• • S-Video PAL

• Component Betacam NTSC• • Component Betacam PAL

• Component Betacam NTSC-J• • Component SMPTE PAL

• Component SMPTE• • Component RGB 

• Component XVGA (HD only)

Note:  When SD and HD formats are available as Primary and Secondary formats, you can 
choose between SD and HD raster for the Analog Output.

Audio Level
Choose between +6 dB (US) monitor level and +0 dB (EBU).

Timecode Input 
Select the type of timecode used by the source video machine—RS-422, Embedded SDI (RP188) 
or choose to input an External LTC timecode source input via the KONA RS-422 port.

Note:  SMPTE RP 188 defines a standard for the transmission of timecode and control code in 
the ancillary data space of a digital television data stream. Timecode information is 
transmitted in the ancillary data space as defined in ANSI/SMPTE 291M. Multiple codes can 
be transmitted within a single digital video data stream. Other time information, such as 
real time clock, DTTR tape timer information, and other user-defined information, may also 
be carried in the ancillary timecode packet instead of timecode. The actual information 
transmitted through the interface is identified by the coding of a distributed binary bit. 
Equipment manufacturers can use the meta data for different purposes.

Desktop Display 
Options

Display To Desktop
Select one of four modes of desktop display:

• Off

• Display while idle only (this mode is suggested)

• Display during capture only 

• Display Always

Display to Desktop uses system resources and could affect performance. Choose Capture Speed, 
Width, and Height as appropriate for your system’s capabilities.
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Display Capture Speed
• Full Speed – Every frame is displayed to desktop during playback

• Half Speed – Every other frame is displayed to desktop during playback

• Quarter Speed – One out of every four frames is displayed to the desktop

Half Speed and Quarter Speed will reduce the system load that the Display-To-Desktop is 
using to draw video to your computer. 

Desktop Capture Width and Height
These selections allow you to reduce the resolution of the desktop capture display. The 
captured file will be full-resolution. Only the displayed image is reduced to save processing 
resources during capture. The choices available are:

• Full Resolution • Eighth Resolution

• Half Resolution • Sixteenth Resolution

• Quarter Resolution

File Options The Premiere Pro Project Setting>Capture menu allows you to select one of the following AJA 
file formats from the Capture Format pulldown menu:

• AJA AVI Capture • AJA QuickTime Capture

• AJA Sequence Capture

Within the AVI and QuickTime formats, you can select one of the following subtypes by 
clicking on the Setup button to the right to bring up the AJA Capture Options menu. 

Note:  Capture file format options vary by KONA card model. The tables provided reflect a 
comprehensive list of supported formats (for KONA 3G). 

Under the File Options panel, select a video format subtype:

When you select AJA Sequence Capture, the File Options panel allows you to choose a 
Sequence Type:

• TGA Sequence• BMP Sequence

• DPX Sequence (LHi and KONA 3G only)• TIF Sequence

• Cineon (LHi and KONA 3G only)• YUV

Within these sequence types, KONA (model dependent) supports the following video 
formats:

AVI files in the following Subtypes QuickTime files in the following Subtypes
8-Bit YUV 4:2:2 – ‘2vuy’
8-Bit YUV 4:2:2 – ‘2Vuy’
8-Bit YUV 4:2:2 – ‘uyvy’
10-Bit YUV 4:2:2 – ‘v210’
8-Bit RGB 4:4:4 – ‘bgr’
8-Bit RGB 4:4:4:4 – ‘bgra’
8-Bit RGB 4:4:4 – ‘bgr’ T2B
8-Bit RGB 4:4:4:4 – ‘bgra’ T2B
10-Bit Log RGB 4:4:4 – ‘R10g’
10-Bit RGB 4:4:4 – ‘R10k’
10-Bit RGB 4:4:4 – ‘r10k’

8-Bit YUV 4:2:2 – ‘2vuy’
8-Bit YUV 4:2:2 – ‘2Vuy’
10-Bit YUV 4:2:2 – ‘v210’
10-Bit YUV 4:2:2 – ‘V210’
8-Bit RGB 4:4:4 – ‘rgb’
8-Bit RGB 4:4:4 – ‘bgr’
8-Bit RGBA 4:4:4:4 – ‘argb’
8-Bit RGBA 4:4:4:4 – ‘rgba’
8-Bit RGBA 4:4:4:4 – ‘bgra’
10-Bit Log RGB 4:4:4 – ‘R10g’
10-Bit RGB 4:4:4 – ‘R10k’
10-Bit RGB 4:4:4 – ‘r10k’
16-Bit RGB 4:4:4 – ‘b48r’
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Audio Formats
• 48 kHz 16-bit PCM Mono• • 48 kHz 16-bit PCM Stereo

• 48 kHz 24-bit PCM Mono• • 48 kHz 24-bit PCM Stereo

• 48 kHz 32-bit PCM Mono• • 48 kHz 32-bit PCM Stereo

Audio Tracks 
Select the number of audio tracks for this project, KONA supports up to eight (four stereo pairs) 
for KONA LHi/LS or 16 for KONA 3G. Adobe Premiere Pro CS5.5 supports six channels.

DPX Sequences in the following Subtypes Cineon Sequences in the following Subtypes
10-Bit Log RGB 4:4:4 (BE) T2B
10-Bit RGB 4:4:4 (BE) T2B
10-Bit Log RGB 4:4:4 (BE) B2T
10-Bit RGB 4:4:4 (BE) B2T
10-Bit Log RGB 4:4:4 (LE) T2B
10-Bit RGB 4:4:4 (LE) T2B
10-Bit Log RGB 4:4:4 (LE) B2T
10-Bit RGB 4:4:4 (LE) B2T

10-Bit Log RGB 4:4:4 (BE)

TGA Sequences in the following Subtypes BMP Sequences in the following Subtypes
10-Bit Log RGB 4:4:4 (BE) T2B
10-Bit RGB 4:4:4 (BE) T2B
10-Bit Log RGB 4:4:4 (BE) B2T
10-Bit RGB 4:4:4 (BE) B2T
10-Bit Log RGB 4:4:4 (LE) T2B
10-Bit RGB 4:4:4 (LE) T2B
10-Bit Log RGB 4:4:4 (LE) B2T
10-Bit RGB 4:4:4 (LE) B2T

8-Bit RGB 4:4:4 B2T
8-Bit RGBA 4:4:4:4 B2T
8-Bit RGB 4:4:4 T2B
8-Bit RGBA 4:4:4:4 T2B

TIF Sequences in the following Subtypes YUV Sequences in the following Subtypes
8-Bit RGB 4:4:4(LE) B2T
8-Bit RGBA 4:4:4:4(LE) B2T
8-Bit RGB 4:4:4(LE) T2B
8-Bit RGBA 4:4:4:4(LE) T2B
8-Bit RGB 4:4:4(BE) B2T
8-Bit RGBA 4:4:4:4(BE) B2T
8-Bit RGB 4:4:4(BE) T2B
8-Bit RGBA 4:4:4:4(BE) T2B
16-Bit RGB 4:4:4(LE) B2T
16-Bit RGB 4:4:4(LE) T2B

8-Bit YUV 4:2:2
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Premiere Pro Playback Options 

To access AJA Playback settings, in Premiere Pro, highlight (select) the Sequence Panel. Then 
either use the fly-down menu in the top right corner of the Premiere Pro project window, or 
go to Sequence>Sequence Settings, and click on the Playback Settings button. 

Player Settings Panel

Note:  Primary Format, SDI and HDMI Outputs have the same functionality as described in   
the Sequence Capture Options panel. See “Capture Options” on page 68..

Audio Device
Select “AJA Audio” to output your project audio through the KONA. To complete audio setup 
refer to “Options Set in Premiere Pro Preferences” on page 64.

Analog Output
Analog Output Options Supported by KONA include:

• Composite + Y/C 

• Component (SMPTE/EBU N10) 

• Component (Beta)

Reference:
Select a source for the video reference signal:

• Free Run (none) • Reference Input (LTC/Ref connector) 

• SDI Input • HDMI Input
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Overlay Options
Enable and select overlay information to be included in the playback by checking the 
appropriate boxes. These overlay controls allow you to insert a graphic file supporting alpha 
channel transparency to apply an effect or insert a bug (logo) over the video content.

HDMI Output Options
HDMI video output offers these options:

• Protocol – choose Auto Detect, HDMI, or DVI

• Color Space – select Auto Detect or YCbCr 10bit (KONA does not support RGB)

• Audio Channels – choose 8 or 2 to be embedded

• Video Range – select SMPTE or Full Range

Advanced Options
Shared Output – the pulldown offers these options:

• Normal– choose for normal output connector routing

• Stereoscopic – select for use with Cineform First Light to control the 3D output. When 
selected and used with KONA 3G, the stereoscopic playback will be output on separate SDI 
outputs, left and right. (For playback output on a single SDI output, you can configure 
Cineform First Light to superimpose the left/right; see Cineform First Light documentation 
for details).

• Video + Key – choose this selection to output a video signal to one SDI output and a related 
Key signal to a second SDI output (useful for outputting to a video switcher for example).

Color Conversion – this menu lets you choose between AJA Hardware or Software conversion.

Quality – This setting can be used to adjust the visual quality and editing/playback 
performance of an AJA sequence in Premiere Pro. The quality setting is actually a setting that 
tells Premiere Pro which algorithms to use when rendering frames. This will apply to both 
scrubbing and playback. Lower quality settings tell Premiere to use faster algorithms for 
functions like deinterlacing, color conversion, transforms, and other effects with a slight penalty 
on visual quality. Higher quality settings use more complex algorithms, which may result in 
visually better results but at the cost of playback and scrubbing speed and performance.

Aggressive Cache
Under General options you can choose to enable Aggressive Cache. When this Option is 
enabled, AJA's plugins will read further ahead in the timeline during playback operations. The 
feature should be used to mitigate minor frame dropping issues. Particularly, this feature was 
created because some DSLR clips can take a very long time to open, and subsequently cause 
frames to drop when they are played back. Using this feature will consume more RAM, and may 
make scrubbing and stop/start commands slightly less responsive. The ideal way to use the 
feature is to leave it off at all times, and then to only turn it on for mastering/layoff to tape.
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Using Photoshop CS5.5

Adobe Photoshop CS5.5 (not included with KONA) accepts KONA plugins and drivers to 
closely integrate KONA functions into the application. After you install the KONA software on 
your workstation, all you need to do to begin using it is to become familiar with the Plugins 
and how Photoshop works with KONA. 

With Photoshop open, you’ll go to the File pull-down menu and select Import>AJA Capture to 
set up your workflow, source device control, and other KONA options. Then access 
Export>AJA Preview Setup to configure the preview output to your monitor. Quick capture 
and simple send-to-preview functions are also available in these menus.

The manual you are reading does not provide operational information for Adobe Photoshop 
CS5.5. Please read the Photoshop user documentation provided with the application for 
information on configuration and operation. The chapter you are reading addresses 
configuration and setup unique to use of KONA with Adobe Photoshop CS5.5.

AJA Image Capture in Photoshop File>Import Menus

The KONA Photoshop plugin is a software application that is integrated into the Photoshop 
CS5.5 application and is accessed under the File menu. The Capture plugin provides you with 
standard tapedeck style play/record functions, status display, and configuration options. The 
Preview plugin allows you to adjust output formats and view your current project frame on a 
monitor connected to a KONA output before rendering to file.

In this section, you will read about the various pull-down options, hot-text entry fields, and 
play/record controls and how they interact.
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Note:  The specific options available to you are determined by the AJA capture device that is 
installed in your workstation and you are currently controlling. This section will describe all 
options for the Photoshop plugin when used with KONA. 

There are three functional areas in the Capture screen as indicated in the following illustration—
Status Display, Play/Record Controls, and Configuration Options. 

KONA Photoshop Capture Plugin Layout

The Status Display area is read-only information about configuration, current status, and 
performance.

The Play/Record Controls offer standard tapedeck controls and more. The hot-text fields 
beneath the video display are for writing and reading timing data. Capture mode will determine 
which fields are operational. 

Note:  Capture Play controls are RS422 machine controls for running a VTR tape deck with 
timecode data. 

• The Configuration Options section contains tabbed menu selections that provide:

• KONA Options – KONA workflow configuration options

• Image Options – Image formatting colorspace, frame, and crop information 
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If you don’t see the Configuration Options section, click on the Options triangle switch above 
the Status Display. In normal operation, you may decide to hide this section when it is not 
needed. 

File>Import>AJA Image Capture

Configuration 
Option Panels

The first Configuration Options tab selects the KONA Options panel for setting Board 
Activation mode and Capture format options. 

Activation Mode
A KONA plugin can be set for Automatic or Manual activation using the Activation Mode pull-
down menu. Automatic is the default setting and is recommended for normal operation. In 
this mode, you merely click between the open plugins to make one active. 

Note:  Only one plugin window can have control of the AJA capture device at a time. If the 
window you click on does not access the KONA (reporting Board: Active), either another 
window is still processing operations or it is set in Manual activation mode and must be 
disabled (check-box empty).

In Manual mode, you must check the Enable KONA box to activate the board control and un-
check it to release control. Upon startup of either Photoshop CS5.5 application, if the 
launched plugin window is in Manual mode, the window will NOT activate until the enable 
box is clicked again.
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The Preview plugin does not need activation since it grabs only one frame (the current working 
frame) at a time for output to the monitor. It grabs the data on a priority basis when it can. The 
rest of the time it is off.

Using the AJA 
Capture Plugin

First, activate the KONA from the Capture window and set up your workflow by defining Input 
and Output formats and timing options. To do this, click on the KONA Options tab. (KONA stores 
the workflow settings you make until they are next changed.) Next, access the Image Options 
tab to set colorspace and framing options and make Alpha Channel (for RGBA scanned-in 
images) and image crop settings if required. Finally, use the General Options menu to set 
timecode and other machine control options. 

KONA Options Menu

Capture Options
These options are the same as those for Premiere Pro except for Display to Desktop. See 
“Capture Options” on page 68..

Display to Desktop allows you turn off the desktop capture display or “Display while idle only.” 
The latter is the suggested mode.
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Image Options 
Menu

After configuring KONA Options, select the Image Options tab. In the Image Options menu 
there are four configuration settings—Colorspace, Frame Scan, Set Alpha Channel, and Crop 
Image.

Photoshop Plugin Image Options Tab

Note:  You can enlarge the thumbnail capture image to full-screen by double-clicking on the 
image. To return, double-click again.

Colorspace – Choose between 8- and 16-bit color in either RGB 4:4:4, or RGBA 4:4:4:4 mode.

Frame Scan – Work with a Full Frame or capture Even or Odd fields only in single or double 
modes.

Set Alpha Channel – The Alpha channel image applies only to RGBA scanned-in images and 
then you can set it to 255 (default) which is zero transparency or 0 which is 100 percent 
transparency when the image is imported into Photoshop.

Crop Image – Use the hot text fields to enter value for pixels cropped from Top, Left, Right, 
and Bottom of the captured image. When you import (Accept) the image into Photoshop, it 
will be cropped to these specifications.



1

79Using Adobe CS5 Applications — Using Photoshop CS5.5

General Options 
Menu

Under the General tab, you will find Device Control Options. These functions are for the  
RS-422 machine control interface on KONA. They support Print-to-Tape machine control.

. 

General Options Tab

Under the General tab, you will find Device Control Options. These functions are for the RS-422 
machine control interface on the KONA card. They support Print-to-Tape machine control.

Timecode Format – Use this pull-down to select the timecode base supported by your VTR.

• Base 24

• Base 25

• Base 25 (50 frames per second)

• Base 30 DF (drop-frame, 30 frames per second)

• Base 30 NDF (non-drop-frame, 30 frames per second)

• Base 30 DF (drop-frame, 60 frames per second)

• Base 30 NDF (non-drop-frame, 60 frames per second)

Timecode Source – Choose between a separate-channel Longitudinal Timecode (LTC) or 
Vertical Interval Timecode (VITC) transported in the video signal’s vertical interval or include 
both (LTC + VITC).

Click on the Hot Text items to enter a value for:

• Preroll – 0 to 15; the number of frames required to start the source machine before capture

• Timecode Offset –  -30 to +30; timecode adjustment (in frames) forward or back to 
compensate for discrepancies between the source’s burned-in timecode and that of the 
captured sequence. 

Status Display If you have more than one AJA capture device installed in your workstation, you can select 
another device to work with by using the Board pull-down menu at the top. If they are set for 
Auto Activation and are idle (not processing), you will immediately take control of the new 
Board (see Basic Plugin Operations and Configuration).

Photoshop Capture Window Status Display
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The Status Display section of the Photoshop Capture plugin, in the left column, reports the 
settings that you have selected for the KONA to use when you have control of it:

• Primary Format 

• Video Input type 

• Selected Colorspace

In the right column Capture Status reports the detected signal status of the KONA input:

Off Line – the capture plugin does not control the KONA
Idle – Ready, the plugin has control and the proper input signal is present
Video Input Not Detected – no input present

Play/Record 
Controls 

Standard tape deck icons provide hot buttons for the Play/Record RS-422 machine control of a 
source VTR. They are:

The slider on the bottom is a variable speed forward/reverse control. Positions from left to 
right are: (Reverse) 16x, 8x, 4x, 2x, 1/2, 1/4, Still, (Forward) 1/4, 1/2, 2x, 4x, 8x, and 16x. The red 
Record button is used to initiate a capture. 

Photoshop Capture Window Play/Record Controls

The pull-down menu on the right enables one of two capture modes:

• Capture Now – manual record/stop (“crash”) capture

• Capture In/Out – initiate a capture using timecode-based in or out settings

The selected mode will activate the appropriate hot text for that mode. Clicking the hot text 
brings up and entry field (hours:minutes:seconds:frames). The upper left display indicates the 
current timecode from the VTR. 

Rewind (8x) Fast Forward (8x)

Reverse Play Reverse 1 frame

Still Stop

Play (1x) Forward 1 frame
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Capture In/Out – Enter a timecode Capture point by clicking on either the left field or right field 
of eight digits in the bracketed fields above the In/Out Duration field. Since Photoshop capture 
is a single-frame function, the In and Out settings will always be the same and the frame 
duration will always be one frame. 

Note:  The in-point/out-point field values are inclusive. When both are set to the same value, 
the capture duration will be 1 frame.

To load the current VTR timecode setting in either field (in-point or out-point) click on the 
bracket ( { or } ) next to the field.

VTR TC – The VTR timecode field displays the current machine timecode and you can click on it 
to roll the VTR to another frame setting. The VTR must be online and in remote rather than local 
control mode (as reported in the VTR Status field.) 

Accept – When you have successfully captured the frame you wish to use in Photoshop, Click on 
Accept in the bottom right corner of the Play/Record pane. The KONA capture plugin will close 
and your frame will be opened in Photoshop for editing.

Using the AJA 
Preview Plugin

The Preview Plugin allows you to view on a monitor the current frame you are working on in 
Photoshop CS5.5. Go to File>Export>AJA Preview Setup to configure previews. When you have 
Preview Setup the way you want it, subsequent Previews are output by selecting AJA Preview 
(below AJA Preview Setup). 

AJA Export Plugins for Photoshop
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The pull-down menu at the top allows you to select any AJA capture device you have installed 
in your workstation (subject to Activation rules). A check box is provided to enable/disable the 
Preview function.

AJA Preview Setup Menu for Photoshop 



1

83Using Adobe CS5 Applications — Using After Effects

The Summary section reports current configuration settings. 

In Preview Options, Primary format is the current format you are using for your project.KONA 
does not support conversion so the Secondary signal format and Convert mode are inactive. 
One SDI output is available and it is always Single Link. Select Analog output type (as 
applicable), and select timing Reference mode—Free Run, External (genlock), or from the video 
Input signal (SDI or HDMI).

In Color Options, KONA does not support colorspace conversion so this function is inactive. 

Finally, for picture quality adjustment, you can output a Test Pattern selection using the pull-
down menu under Test Options. Click OK to output your Preview.

Using After Effects

KONA After Effects 
CS5.5 Plugin 
Overview

A KONA After Effects CS5.5 Preview plugin adds KONA functions to the After Effects CS5.5 
application. The KONA plugin screen is  accessed under the Window pulldown menu. The 
Preview plugin allows you to view the current frame of your working timeline in various formats 
on a monitor connected to a KONA output.The Status Display area is read-only information 
about configuration, current status, and performance.

This section discusses settings common across plugin windows and how they interact. 

Activation Mode
A KONA plugin can be set for Automatic or Manual activation using the Activation Mode pull-
down menu. Automatic is the default setting and is recommended for normal operation. In this 
mode, you merely click between the open plugins to make one active. 

Note:  Only one plugin window can have control of the KONA at a time. If the window you click 
on does not access the card (reporting Board: Active), either another window is still 
processing operations or it is set in Manual activation mode and must be disabled (check 
box blanked).

In Manual mode, you must check the Enable KONA box to activate KONA control and un-check 
it to release control. Upon startup of the After Effects CS5.5 application, if the launched plugin 
window is in Manual mode, the window will NOT activate until the enable box is clicked again.

After Effects CS5.5 and Preview Note
Double clicking on a captured Project File in the project bin will sometimes open the file in an 
After Effects CS5.5 player which can be previewed. Some formats will result in the file opening in 
a third-party viewer (QuickTime for example)—but the file cannot be previewed in that viewer.
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Using the After Effects Preview Plugin 

The Preview Plugin allows you to view on a monitor the current frame you are working on in 
the timeline as it will appear at the KONA output. A summary area at the top of the Preview 
window shows how the KONA is currently configured. If you wish to change it, you can use the 
Preview Options below. 

AJA Preview Plugin

In Preview Options, you can vary the Primary and Secondary signal formats, Convert mode, 
YUV to RGB range (see earlier discussion under the AJA Capture Plugin), SDI and Analog 
output type (as applicable), and select timing Reference mode—Free Run, External (genlock), 
or from the video Input signal.

 Color Options, KONA does not currently support colorspace conversion.

You can output a Test Pattern selection using the pull-down menu under Test Options. 
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Chapter 6: Using Eyeon Fusion 

6

Using Eyeon Fusion

The KONA Fusion 6 plugin is a software application integrated into Fusion that allows you to 
preview your current Fusion project from the KONA output. Go to File>Preferences to setup 
AJA Preview. Note: KONA Software for Windows version 5.5 is for 64-bit Eyeon Fusion only.

Selecting AJA Preview for Fusion
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Under Globals and new comp defaults->Preview select AJA Preview from the “Display file 
sequences on:” pull-down menu. To set up AJA Preview formatting, continue down to the I/O 
selections under Globals and new comp defaults and then choose AJA Preview.

AJA Preview Setup Menu for Fusion

Preview Options If there is more than one AJA capture device installed in your system, a pull-down menu at 
the top allows you to select which device to control (subject to Activation rules). 

In Preview Options, you can change the Primary and Secondary video signal formats and 
Analog output type (as applicable), and select timing Reference mode—Free Run, External 
(genlock), or from the video Input signal. 

Finally, for picture quality adjustment, you can output a Test Pattern selection using the 
pull-down menu under Test Options. Click OK to output your Preview.

Note:  Fusion AJA Preview, in most cases, will not be in realtime for any RAM Preview. 
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Activation Note:  Only one plugin window can have control of the KONA card at a time. If the application 
window you click on does not access the card (panel fields are inactive), either another 
application is still processing operations or it may have a Manual activation mode and must 
be disabled (check box blanked) to release control of the KONA. Activation Mode is 
available in these applications:

• AJA’s Machina

• Adobe After Effects CS5.5

• Adobe Photoshop CS5.5

Primary & 
Secondary Formats

The Primary Format menu allows you to select the video format to be used in the current project 
in the KONA framebuffer. (The current selection is reported in the display of the pull-down 
menu.) Secondary Format allows you to perform signal format conversions.

Choices are always presented based on which AJA capture device you are using and what signal 
formats it supports. 

Primary Video Formats Supported 
Refer to “Selection of Primary & Secondary Formats ” on page 31 for detailed information on  
video formats and conversions.



88



11

Chapter 7: Third-Party Applications 

7

Native Support for KONA for PC Products 

The following third-party applications provide native support for specified AJA KONA for PC 
capture cards. This list is not all-inclusive. Other applications not listed may also support 
KONA cards. If you have problems related to hardware functions while using these 
applications, contact AJA Support and we will do our best to promptly verify and resolve 
them. If your problems are software related please contact the application manufacturer. 
Contact phone numbers and URLs are provided below.

Note:  Some vendors may have a fee structure for customer support services.

Drastic 
Technologies  
Media NXS

The Media NXS software-based digital disk recorder application supports KONA 3G, and LHi, 
cards for uncompressed capture and playback. Media NXS supports a wide range of hardware 
platforms including Uncompressed 8/10-Bit Y’CrCb and video standards ranging from NTSC/
PAL to 1080x1920 HDTV.

Application KONA Card 
Supported Support Contacts

Drastic Technologies
Media NXS

KONA 3, 
KONA 3G, 
LHi, 

1-416-255-5636
email: support@drastictech.com

CineForm 
Prospect HD, Prospect 4K, 
Neo HD, Neo HD 3D, & 
Neo 4K

KONA 3, KONA 
3G, LHi

http://supportcenteronline.com/ics/support/default.asp?deptID=614

The Foundry
NUKE

KONA 3G, LHi http://www.thefoundry.co.uk/products/nuke/
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Appendix A: Troubleshooting 

A

If You Run Into Problems

One useful way to find the source of problems is to isolate your system to the smallest size 
where the problem still occurs and then note all the symptoms. This serves to eliminate areas 
not involved in the problem and makes finding the problem easier. 

Once you’ve noted problem symptoms, look through the following table and see if any of the 
symptoms are listed. If so, check the items listed. If you later need to call for customer service, 
let them know all of the things you’ve tried and when and how the symptoms appeared.

Updating Software

Check for software updates on the AJA Video website:

http://www.aja.com/support/index.php

If any are available, download the file and read any associated instructions prior to installing 
the software.

Support

When calling for support, first check over your system configuration and ensure everything is 
connected properly and that current Final Cut presets and Easy Setups match what you are 
trying to do. Even if you cannot find the cause of the problem, having this information at hand 
will help when you call Apple or AJA Customer Support for help.

If the problem is unknown or you need general help, first contact the dealer where you 
purchased the product. AJA dealers offer product support for many service requirements. 

If the problem is a Final Cut Pro operational issue, Mac Pro system issue, or Xserve RAID issue, 
then call Apple Customer Support for help. 

If the problem is an AJA Video KONA issue, contact AJA Video Customer Support using one of 
the methods listed below:

Contacting by Mail Address: 
180 Litton Drive, Grass Valley, CA. 95945 USA 
Telephone: 1.800.251.4224 or 1.530.274.2048 
Fax: 1.530.274.9442
Web: http://www.aja.com 
Support Email: support@aja.com
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Frequently Asked Questions

Can I use SATA Drives for RAID storage with the KONA product line?
AJA always recommends the use of SCSI or Fibre Channel storage solutions for use with 
KONA products.

I updated the KONA software and my KONA hardware is now missing, 
Why?
A function of the uninstaller is removing the current driver for the KONA card. In doing this 
the KONA hardware is removed completely. A “plug and play” request must be made to 
install a new driver for the hardware. This can be done be either restarting the system or 
going into device manager and searching for new hardware. On startup the computer 
automatically looks for new or uninstalled hardware.

Can the KONA handle HDV, P2, XDCam, or AVCHD? If so how?
HDV, XDCam, P2, and AVCHD files will play real-time in Premiere Pro when using AJA 
supplied project presets. Alternatively, you can use KONA to capture uncompressed from 
these cameras if they have SDI, HDMI, or Analog outputs.

Does KONA Offer Support for compressed codecs?
All KONA cards can capture DV 25 and DV 50 compressed QuickTime files from analog and 
digital sources through their available inputs. Also, DVCProHD compressed QuickTime files 
can be captured for HD resolutions. Please see our DVCProHD white papers (see the 
whitepaper DVCProHD Editing with KONA and KONA at

http://www.aja.com/pdf/AJA_whitepaper_DVCProHD_editing.pdf).

I am using After Effects for compositing and sometimes my preview is 
not in real time—why is this?
RAM Preview should be very close to real-time for HD in After Effects. Please ensure you 
have the following settings for proper RT RAM preview.

1. Make sure that the “Primary Format” of the AJA Preview Panel in AE matches the 
resolution and frame rate of your After Effects Composition.

2. Also, RT RAM Preview is only possible with 8-bit AE Projects and with the “8-bit RGBA 
4:4:4:4” setting for the “Output 8-bit As:” found in the AJA Preview Panel Color 
Options. Other color spaces and AE Project depths require a software transformation 
of the video data before being displayed—thus slowing down preview. 

3. Next, please ensure that the “Resolution” setting for “Time Controls” is set to “Full”. If 
not set to “Full,” the image that the AJA Preview Panel receives and sends to the 
KONA board during RAM Preview will not be sent at “Full Resolution” and thus will 
either be software resized to Full Resolution before sending to the KONA Board for 
display, or will be center cropped before sending. The latter choice is controlled by 
the checkbox in the AJA Preview Panel labeled “Auto Resize Image” under the 
“Primary Format” Setting.

4. If RAM Preview is still not real-time, you can try some of the following – setting your 
Zoom to “100%” in your AE Composition, making sure the “Frame Rate” of the AE 
Time Controls” matches the frame rate of the “Primary Format” in the AJA Preview 
Panel, and muting audio in the AE Time Controls.
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Note:  In some cases the available bandwidth of the motherboard limits the cards ability 
to output full frame rate 1080i 29.97 RGBA.

How does KONA hardware Up-convert, Cross-convert or Down-con-
vert?
The KONA 3G and LHi can perform many different conversions of a video source. They can 
convert only when video is passing across the board. So in capture or playback you have 
the ability to convert video in hardware in real-time with no CPU/Memory cost.

Can I work with 720p variable frame rates?
KONA will automatically remove duplicate frames from varicam footage as long as the  
RP-188 flags are set correctly. However, this footage will have 29.97 fps timecode. KONA 
does not attempt time code conversion, so the timecode in captured files will not be 
reliable.

What file formats are supported by KONA?
We support the following formats:

AVI files in the following Subtypes QuickTime files in the following Subtypes

8-Bit YUV 4:2:2 – ‘2vuy’
8-Bit YUV 4:2:2 – ‘2Vuy’
8-Bit YUV 4:2:2 – ‘uyvy’
8-Bit YUV 4:2:2 – ‘v210’
8-Bit RGB 4:4:4 – ‘bgr’
8-Bit RGB 4:4:4:4 – ‘bgra’
8-Bit RGB 4:4:4 – ‘bgr’ T2B
8-Bit RGB 4:4:4:4 – ‘bgra’ T2B
10-Bit Log RGB 4:4:4 – ‘R10g’
10-Bit RGB 4:4:4 – ‘R10k’
10-Bit RGB 4:4:4 – ‘r10k’

8-Bit YUV 4:2:2 – ‘2vuy’
8-Bit YUV 4:2:2 – ‘2Vuy’
8-Bit YUV 4:2:2 – ‘v210’
8-Bit RGB 4:4:4 – ‘rgb’
8-Bit RGB 4:4:4 – ‘bgr’
8-Bit RGB 4:4:4:4 – ‘argb’
8-Bit RGB 4:4:4:4 – ‘bgra’
8-Bit RGB 4:4:4:4 – ‘rgba’
10-Bit Log RGB 4:4:4 – ‘R10g’
10-Bit RGB 4:4:4 – ‘R10k’
10-Bit RGB 4:4:4 – ‘r10k’

DPX Sequences in the following Subtypes Cineon Sequences in the following Subtypes

10-Bit Log RGB 4:4:4 (BE) T2B
10-Bit RGB 4:4:4 (BE) T2B
10-Bit Log RGB 4:4:4 (BE) B2T
10-Bit RGB 4:4:4 (BE) B2T
10-Bit Log RGB 4:4:4 (LE) T2B
10-Bit RGB 4:4:4 (LE) T2B
10-Bit Log RGB 4:4:4 (LE) B2T
10-Bit RGB 4:4:4 (LE) B2T

10-Bit Log RGB 4:4:4 (BE)

TGA Sequences in the following Subtypes BMP Sequences in the following Subtypes

8-Bit RGB 4:4:4 B2T
8-Bit RGB 4:4:4:4 B2T
8-Bit RGB 4:4:4 T2B
8-Bit RGB 4:4:4:4 T2B

8-Bit RGB 4:4:4 B2T
8-Bit RGB 4:4:4:4 B2T
8-Bit RGB 4:4:4 T2B
8-Bit RGB 4:4:4:4 T2B

TIF Sequences in the following Subtypes YUV Sequences in the following Subtypes

8-Bit RGB 4:4:4(LE) B2T
8-Bit RGB 4:4:4:4(LE) B2T
8-Bit RGB 4:4:4(LE) T2B
8-Bit RGB 4:4:4:4(LE) T2B
8-Bit RGB 4:4:4(BE) B2T
8-Bit RGB 4:4:4:4(BE) B2T
8-Bit RGB 4:4:4(BE) T2B
8-Bit RGB 4:4:4:4(BE) T2B

8-Bit YUV 4:2:2
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Are there any important things to be aware of when setting up a RAID 
for Video capture?
Many SCSI and Fiber raids that use SATA or IDE with a backplane and controller often offer 
user settings for configurations. Be sure to format the Physical disk in a 512 Block size and 
never exceed a single volume size of 2TB. Multiple 2TB (or below) can be striped together by 
the OS for larger capacity storage.

I captured a QuickTime file and then renamed it when the system 
prompted me to save it—why did it take so long to save?
When KONA is capturing, it creates separate audio & video files based on the name the clip 
is logged with and then multiplexes the audio & video together at the end of the capture. If 
the user renames this clip after the capture, a duplicate clip has to be regenerated and re-
multiplexed.
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Appendix B: Specifications

B

KONA 3G Specifications

PCI Bus
PCIe 4-lane compatible

Video Formats

Video Input
Digital:

SD, HD, and 3G SDI, SMPTE-259/292/424
Single Link 4:2:2
Single Link 3G HD 4:4:4
2K HSDL (High Speed Data Link) 4:4:4

Analog:
SD and HD Output, 12 bits, BNC
HD: YPbPr, RGB
SD: YPbPr, RGB (component mode)
Composite/YC (composite mode)
12-bit D/A

Standard Def HD 720 HD 1080 2K

525i 29.97 720p 23.976 1080i 25 2048 x 1080p 23.976

525i 29.97 (WIDE) 720p 24 1080i 29.97 2048 x 1080psf 23.976

625i 25 720p 25 1080i 30 2048 x 1080p 24

625i 25 (WIDE) 720p 29.97 1080p 23.976 2048 x 1080psf 24

480i 29.97 720p 30 1080psf 23.976 2048 x 1556p 14.98

480i 29.97 (WIDE) 720p 50 1080p 24 2048 x 1556p 15

720p 59.94 1080psf 24

720p 60 1080p 25

1080psf 25

1080p 29.97

1080psf 29.97

1080p 30

1080psf 30

1080p 50

1080p 59.94

1080p 60
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Video Output
Digital:

SD-SDI, SMPTE, 259M, 10-bits, BNC
HD-SDI SMPTE, 292/296, 10-bits, BNC
Dual-link HD 4:4:4 and 2K HSDL 4:4:4
HDMI v1.4a, 30/36 bits/pixel, RGB or YUV, 2.25Gbps

Analog SD and HD Output, 12-bits, BNC:
HSD and HD Output, 12-bits, BNC
HD: YPbPr, RGB
SD: YPbPr, RGB (component mode) or
Composite + Y/C (composite mode with simultaneous Y/C)

Audio
16/24/32-bit 48 kHz synchronous
16-channel SDI/HD-SDI embedded audio 
sample rate conversion on AES inputs
(no source synchronization required)

Up-Conversion
Hardware 10-bit
Aspect conversion modes:

Anamorphic – full-screen
Pillar box 4:3 – results in a 4:3 image in

center of screen with black sidebars
Zoom 14:9 – results in a 4:3 image zoomed 

slightly to fill a 14:9 image with black sidebars
Zoom Letterbox – zooms a 16:9 Letterbox source

to full-screen
Zoom Wide – results in a combination of zoom and

horizontal stretch to fill a 16:9 screen; this setting 
can introduce a small aspect ratio change

Down-Conversion
Hardware 10-bit 
Anamorphic – full-screen
Letterbox – 16:9 image with black top and bottom
Crop – image is cropped for full-screen image

Cross-Conversion
Hardware 10-bit
1080i to 720p
720p to 1080i

SD to SD Aspect Ratio Conversion
16:9 to 4:3 Letterbox
16:9 to 4:3 Horizontal Crop
4:3 to 16:9 Pillarbox
4:3 to 16:9 Vertical Crop

Reference Input
Analog Color or HD Tri-level
1 BNC on standard breakout cable 
(75 Ohm terminating)

Machine Control
RS-422, Sony 9-pin protocol
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KONA LHi Specifications

KONA LHi
PCIe 4-lane compatible

Look Up Tables
Real-time primary LUT
Import/export text-based LUT files

File Import/Export
Import (capture) and export (playback) standard
file formats: DPX, Cineon, TGA, TIFF,
BMP, and AVI,QuickTime.

Video Formats

Video Input
Digital:

HD-SDI/SDI, SMPTE-259/292/296
HD-SDI 1.5Gb and 3Gb
HDMI v1.3, 30 bits/pixel, 

RGB or YUV, 2.25Gbs, SD, HD, 1080p50/60
Analog:

SD and HD Input, BNC
HD: YPbPr, RGB
SD: YPbPr, RGB (component mode)
Composite/YC (composite mode)
12-bit A/D

Video Output
SD and HD Output, BNC
HD: YPbPr, RGB
SD: YPbPr, RGB (component mode)
Composite/YC (composite mode)
12-bit D/A

Standard Def HD 720 HD 1080

525i 29.97 720p 23.976 1080i 25

625i 25 720p 24 1080i 29.97

720p 25 1080i 30

720p 29.97 1080p 23.976

720p 30 1080psf 23.976

720p 50 1080p 24

720p 59.94 1080psf 24

720p 60 1080p 25

1080psf 25

1080p 29.97

1080psf 29.97

1080p50, 59.94, 60

1080p 30

1080psf 30
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HD-SDI 1.5Gb and 3Gb
HDMI v1.3, 30 bits/pixel,

RGB or YUV, 2.25Gbs, SD, HD, 1080p50/60

Audio Input
Digital:

2-channel 16/24/32-bit AES/EBU, 48 kHz sample rate
Synchronous or Non-synchronous
(Internal sample rate conversion)
16/24/32-bit SMPTE-259 SDI embedded audio, 8-Ch, 48 kHz synchronous

Analog:
2-channel balanced input
+24dbu Full-scale Digital (0dbFS)
16/24/32-bit D/A, 48 kHz sample rate
+/- 0.2db 20 to 20 kHz Frequency Response

Audio Output
Digital:

2-channel 16/24/32-bit AES/EBU, 48 kHz sample rate
16/24/32-bit AES/EBU, 48 kHz sample rate
16/24/32-bit SMPTE-259 SDI embedded audio, 8-Ch, 48 kHz synchronous

Analog:
2-channel balanced output
+24dbu Full-scale Digital (0dbFS), 16/24/32-bit D/A, 48 kHz sample rate
+/- 0.2db 20 to 20 kHz Frequency Response

Up-Conversion
Hardware 10-bit
Aspect conversion modes:

Anamorphic – full-screen
Pillar box 4:3 – results in a 4:3 image in

center of screen with black sidebars
Zoom 14:9 – results in a 4:3 image zoomed 

slightly to fill a 14:9 image with black sidebars
Zoom Letterbox – zooms a 16:9 Letterbox source

to full-screen
Zoom Wide – results in a combination of zoom and

horizontal stretch to fill a 16:9 screen; this setting 
can introduce a small aspect ratio change

Down-Conversion
Hardware 10-bit output, 16/24/32-bit internal processing
Anamorphic – full-screen
Letterbox – image is reduced with black top and bottom added

to image area with the aspect ratio preserved
Crop – image is cropped horizontally

Cross-Conversion
Hardware 10-bit
1080i to 720p, 720p to 1080i

SD to SD Aspect Ratio Conversion
16:9 to 4:3 Letterbox
16:9 to 4:3 Horizontal Crop
4:3 to 16:9 Pillarbox
4:3 to 16:9 Vertical Crop
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Reference Input
Analog Color or HD Tri-level
1 BNC on standard breakout cable (75 Ohm terminating)
KLHI-Box (optional): 2 BNCs, passive loop
BNC assignable as LTC input

Machine Control
RS-422, Sony 9-pin protocol
Connector provided on KONA LHi breakout cable and on optional KLHI-Box.

LHe Plus Specifications

Formats

Video Input

Digital: 8 or 10 bit HD-SDI/SDI, SMPTE-259/292/296, Dual-rate

Analog:

Composite/S-Video (Y/C): NTSC, NTSCJ, PAL
12 bit A/D, 2x oversampling 
3 line adaptive comb filter decoding
+/- .25 db to 5.0 MHz Y Frequency Response
+/- .25 db to 1 MHz C Frequency Response
.5% 2T pulse response
< 1.5% Diff Phase
< 1.5% Diff Gain

Component: SMPTE/EBU N10, Betacam 525 line, Betacam 525J, RGB
12 bit A/D, 2x oversampling 
+/- .25 db to 5.5 MHz Y Frequency Response
+/- .25 db to 2.5 MHz C Frequency Response
.5% 2T pulse response
<2 ns Y/C delay inequity

Standard Def HD 720 HD 1080

525i 59.94 720p 50 1080i 50

625i 25 720p 59.94 1080i 59.94

720p 60 1080i 60

1080PsF 23.98

1080PsF 24

1080PsF 25

1080PsF 29.97

1080PsF 30

1080P 23.98

1080P 24

1080P 25

1080P 29.97

1080P 30
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Video Output

Digital: SD-SDI, SMPTE, 259M, 10-bits, BNC
   HD-SDI SMPTE, 292/296, 10-bits, BNC

Analog:
Composite/S Video: NTSC, NTSCJ, PAL

12 bit D/A, 8x oversampling 
+/- .2 db to 5 MHz Y Frequency Response
+/- .2 db to 1 MHz C Frequency Response
.5% 2T pulse response
< 1% Diff Phase
< 1% Diff Gain

SD Component: SMPTE/EBU N10, Betacam 525 line,  
   Betacam 525J, RGB

12 bit D/A, 8x oversampling 
+/- .2 db to 5.5 MHz Y Frequency Response
+/- .2 db to 2.5 MHz C Frequency Response
.5% 2T pulse response
<1 ns Y/C delay inequity

Analog SD and HD Output, 12-bits, BNC:
HD: YPbPr, RGB
SD: YPbPr, RGB (component mode)

Composite/YC (composite mode)

Audio Input

Digital: 2-channel 24 bit AES/EBU, 48KHz sample rate
Synchronous or Non-synchronous 
(Internal sample rate conversion)
24 bit SMPTE-259 SDI embedded audio, 8-ch, 48kHz synchronous

Analog: 2-channel balanced input
+24dbu Full Scale Digital
24 bit A/D, 48 KHz sample rate 
+/- 0.2db 20 to 20 KHz Frequency Response

Audio Output

Digital: 2-ch 24-bit AES/EBU, 48 KHz sample rate
24 bit SMPTE-259 SDI embedded audio, 8-ch, 48 KHz synchronous

Analog: 2-channel Balanced output (XLR)
+24dbu Full Scale Digital (0dbFS)
24 bit D/A, 48 KHz sample rate 
+/- 0.2db 20 to 20 KHz Frequency Response

              2-channel unbalanced output (RCA-jack): requires KL-Box option
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Down-Conversion

Hardware: 10-bit output, 24-bit internal processing
Anamorphic: full-screen
Letterbox: image is reduced with black top and bottom added to image 
       area with the aspect ratio preserved
Crop: image is cropped horizontally

Reference Input

Analog Color Black or HD Tri-level
1 BNC on standard breakout cable (75 ohm terminating)
KL-Box (optional): 2 BNCs, passive loop-through

Hardware Acceleration Provided

DVCProHD hardware acceleration 
HDV hardware acceleration 
Dynamic RT Extreme hardware acceleration 

Machine Control
RS-422, Sony 9-pin protocol
Connector provided on KONA LHi breakout cable and on optional KLHI-Box.
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